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Einführung: Lernen Sie Ihre Werkzeuge kennen 
 
Mit Ihrer Kopie von Titan Quest wurden bereits einige Modding-Werkzeuge automatisch installiert. Dies sind dieselben, 
die zur ursprünglichen Erstellung von Titan Quest verwendet wurden und dementsprechend leistungsfähig! Am 
einfachsten finden Sie die Werkzeuge im Startmenü unter Alle  Programme/THQ/Titan Quest/Toolset . Es sind im Detail: 
 

·  Art Manager – Basisprogramm, um Ihre Mods zu verwalten 
·  Editor – Erstellen von Leveln 
·  Quest Editor – Erstellen von Quests 

 
Einige der Tutorials in dieser Anleitung beziehen sich auf Tutorial-Projekte, die wie unten beschrieben in das 
Arbeitsverzeichnis installiert werden. Die Nummerierung ist dabei in beiden Fällen identisch; also Tutorial01 entspricht der 
ersten Sektion weiter unten in dieser Anleitung usw. Wenn Sie ein wenig abenteuerlustig sind, können Sie gerne die 
Projekte durchforsten und selbst ausprobieren. 
 
 
Setup 
Wie bereits erwähnt, finden Sie die Werkzeuge am leichtesten im Startmenü unter Programme/THQ/Titan 
Quest/Toolset . Als erstes sollten Sie den Art Manager starten. Sie werden nun aufgefordert, Ihr Arbeitsverzeichnis zu 
wählen. Wir empfehlen, die Voreinstellungen zu übernehmen, indem Sie einfach auf „OK“ klicken. 
 
Der Art Manager öffnet sich nun, und das Arbeitsverzeichnis wird unter Eigene Dateien/My Games/Titan Quest  erstellt. 
Als nächstes klicken Sie im Menüpunkt „Help“ (in der Menüleiste) auf „Install Tutorials“. Daraufhin werden die Tutorial-
Dateien installiert, die Sie benutzen sollten, während Sie diese Anleitung lesen. Nun müsste alles vorbereitet sein, und 
Sie können fortfahren, sobald Sie bereit sind. 



Tutorial 1: Grundlagen der Navigation und der Objek t-Platzierung 
  
 Das erste Tutorial ist eine Einführung, die Ihnen helfen soll, sich im Editor zurecht zu finden und Ihre Level so zu 
erstellen, dass sie im Spiel eingesetzt werden können. Als erstes wollen wir eine kleine Auseinandersetzung mit einigen 
Monstern kreieren, um möglichst bald ins Spiel und zum Kämpfen zu gelangen. 
 
1.0.1 Eine Spielwelt in den Editor laden 
 Wenn Sie den Titan Quest Editor starten, werden Sie als erstes dazu aufgefordert, eine Welt zu öffnen. 
 

1) Wählen Sie im Dropdown-Menü unter „Mod name “ „Tutorial01“ aus. 
2) Es erscheint ein Verzeichnisbaum. Erweitern Sie „source“, dann „Maps” und klicken Sie auf „Tutorial-

Basic_Navigation.wrl”. 
3) Klicken Sie auf „OK“. 

 

 
 
 



1.1 Sich im Editor zurechtfinden 
 
1.1.2. Der Layout Mode 
 Nach dem Laden der Welt öffnet sich als erstes der Layout Mode Bildschirm. Dieser zeigt Ihnen die Welt mit 
allen darin befindlichen Leveln. Ein Level  ist ein kleines Segment einer Welt, das sich wie ein Puzzle-Stück verschieben 
lässt. Durch die Unterteilung einer Welt in Level werden lange Ladezeiten vermieden, während man sich durch die 
Spielwelt bewegt. 

 
 
 Wenn Ihre Welt wächst, wird es nötig, die Kamera zu bewegen, um eine bessere Übersicht über das 
Arrangement der einzelnen Level in der Welt zu bekommen.  
1) Zum Bewegen  der Kamera halten Sie die rechte Maustaste gedrückt, und bewegen Sie die Maus. 
2) Zum Rotieren der Kamera halten Sie die mittlere Maustaste gedrückt, und bewegen Sie die Maus nach links oder 
rechts. 
3) Zum Zoomen der Kamera benutzen Sie das Mausrad.  
 
1.1.3 Ein Level zum Bearbeiten auswählen 
1) Wählen Sie die Box in der Mitte des Layout Mode Bildschirms aus. 
 Sie werden bemerken, dass die Box hervorgehoben und ihr Name darüber eingeblendet wird. Der Layout Mode 
eignet sich besonders gut zum Platzieren der einzelnen Level und zur Übersicht über die Beziehungen zur Umgebung. 
Zum eigentlichen Bearbeiten der Level benötigen wir den Editor Mode . Das Editieren kann vom Layout Mode oder vom 
„Editor Mode“ Fenster aus gestartet werden. 
 
Layout Mode: 
2A) Selektieren Sie ein Level zum Bearbeiten. 
3A) Drücken Sie den „Mode-Wechsel-Knopf”. 

 
 
Editor Mode: 
2B) Wählen Sie die Editor Mode Registerkarte am Unterrand des Bildschirms. 
3B) Einmal im Editor Mode angekommen, können Sie das Dropdown-Menü in der oberen rechten Ecke benutzen, um das 
gewünschte Level auszuwählen. 



 
 
Beispiel 1.1.4 Der Editor Mode 
 Nach kurzer Ladezeit sollten grasbewachsene Hügel zum Vorschein kommen, ähnlich den unten gezeigten. Dies 
ist das Level, welches wir bearbeiten wollen. Da das ganze Level nicht auf den Bildschirm passt, müssen Sie die Kamera 
wie oben bereits beschrieben bewegen. 

 
1) Zum Bewegen  der Kamera über den Boden halten Sie die rechte Maustaste gedrückt, und bewegen Sie die Maus. 
2) Zum Rotieren der Kamera um einen Punkt am Boden halten Sie die mittlere Maustaste gedrückt, und bewegen Sie die 
Maus nach links oder rechts. 
3) Zum Zoomen benutzen Sie das Mausrad, um näher an die Oberfläche zu kommen oder sich von ihr zu entfernen.  
 
 
 
1.2 Objekte platzieren  
 
Beispiel 1.2.1 Objekte platzieren 
Nachdem wir nun gelernt haben, uns im Level zurecht zu finden, sollten wir einige Objekte platzieren. Um das zu tun, 
müssen Sie zuerst auswählen, um welche Art von Gegenstand es sich handeln soll. Anschließend klicken Sie auf die 
Stelle, an der der Gegenstand im „Level Edit “ Fenster  positioniert werden soll. Fangen wir am besten damit an, ein paar 
Satyre in die Welt zu setzen. 
1) Wählen Sie das Objekt-Platzierungs-Werkzeug aus. 

 
2) Suchen Sie im rechts gelegenen Verzeichnis-Fenster das Objekt „records -> creature -> monster -> satyr -> 
am_peltast_02“ und klicken Sie mit der Maus darauf. 
3) Klicken Sie nun auf das Gelände im „Level Edit“ Fenster, um den Satyr zu platzieren. 
4) Um einen weiteren Satyr zu platzieren, klicken Sie erneut auf den Namen des Objekts im Vezeichnis-Fenster. 
5) Anschließend klicken Sie auf das Gelände im „Level Edit“ Fenster. 
 
Tipps 



• Sie können mehrere Kopien eines Objekts platzieren, indem Sie während des Klickens die Strg-Taste gedrückt halten.  
• Wenn Sie die „Randomize rotation“ Box im rechten Fenster anklicken, werden die Objekte mit zufälliger Ausrichtung 
platziert. So wird vermieden, dass die Objekte alle in dieselbe Richtung zeigen.  
• Wenn Sie die „Snap to grid“ Box anklicken, werden die Objekte beim Setzen mit dem nächst gelegenen Schnittpunkt auf 
dem Höhenkarten-Raster verbunden. Dies ist insbesondere praktisch zum Ausrichten von Dingen wie Mauern oder 
Gebäuden. 
 
1.2.2 Objekte löschen  
 Das Löschen von Objekten ist ziemlich intuitiv. 
1) Wählen Sie das zu löschende Objekt durch Klicken mit der Maustaste aus. 
2) Drücken Sie die Entf-Taste auf Ihrem Keyboard. 
 
 
1.3 Objekte bewegen 
 
 Wie bewegen wir nun ein Objekt, nachdem wir es platziert haben? Es gibt drei Arten von Bewegungen für ein 
Objekt: seitliche Bewegung (horizontal), vertikale Bewegung und Drehung (Rotation). 
 
1.3.1 Seitliche Bewegung eines Objekts   
Die seitliche Bewegung legt fest, wo sich ein Objekt im Gelände befindet. 
1) Klicken Sie mit der linken Maustaste auf das zu bewegende Objekt. 
 Es erscheint nun ein Bewegungsindikator am Boden des Objekts. 

 
2) Bewegen Sie den Mauszeiger zur Mitte des Bewegungsindikators (dort, wo das Kreuz ist). 
 Sie werden feststellen, dass sich der Mauszeiger in einen Vier-Wege-Pfeil verwandelt.  

 
3) Wenn dieser Pfeil erscheint, können Sie das Objekt durch Drag and Drop über das Gelände ziehen. 
 
1.3.2 Vertikale Bewegung eines Objekts 
Die vertikale Bewegung bestimmt, wie hoch über oder tief unter der Erde sich das Objekt befindet. 
1) Klicken Sie mit der linken Maustaste auf das zu bewegende Objekt. 
 Es erscheint nun ein Bewegungsindikator am Boden des Objekts. 
2) Bewegen Sie den Mauszeiger zum inneren Ring des Bewegungsindikators. 
 Sie werden feststellen, dass sich der Mauspfeil in einen Zwei-Wege-Pfeil nach oben und unten verwandelt. 

 
3) Jetzt können Sie das Objekt durch Drag and Drop in die Luft oder unter die Erde bewegen. 
 
1.3.3 Drehen eines Objekts 
Die Rotation  bestimmt, in welche Richtung ein Objekt zeigt. 
1) Wählen Sie als erstes das gewünschte Objekt durch Klicken mit der linken Maustaste aus. 
2) Bewegen Sie den Mauszeiger zum äußeren Ring des Bewegungsindikators am Boden des Objekts. 
 Der Zeiger sollte sich in einen kreisförmigen Pfeil verwandeln. 

 
3) Durch Gedrückthalten der Maustaste und Bewegen der Maus können Sie verändern, in welche Richtung das Objekt 
zeigt. Dieser Modus ist für Mausbewegungen nicht sehr sensibel, so dass Sie ggf. lange Wege zurücklegen müssen, um 
beispielsweise eine 180° Drehung zu vollführen. 
 
1.3.4 Objekte ebenerdig ausrichten  
Durch Drücken der Leertaste  werden ausgewählte Objekte automatisch ebenerdig angeordnet. Dabei werden sie immer 
auf den Erdboden platziert; um Objekte auf andere Objekte zu setzen, müssen Sie die Höhe abschätzen. 
 
1.3.5 Mehrere Objekte auf einmal  auswählen 



Es gibt zwei verschiedene Wege, um mehrere Objekte gleichzeitig auszuwählen: die Auswahl-Box und mittels Strg-Taste 
und Mausklick.  
 
Auswahl-Box 
1. Ziehen Sie bei gehaltener linker Maustaste eine Auswahl-Box um die Objekte, die Sie markieren wollen.  
2. Sämtliche Objekte innerhalb dieser Box werden ausgewählt.  
 
Strg-Taste + linke Maustaste  
1. Klicken Sie mit der linken Maustaste auf ein Objekt.  
2. Halten Sie die Strg-Taste gedrückt und klicken Sie mit der linken Maustaste auf ein weiteres Objekt. 
3. Jedes neue Objekt wird der Gruppe hinzugefügt.  
 
1.3.6 Kopieren und Einfügen von Objekten  
Objekte im Spiel können kopiert und an einer anderen Position in der Welt eingefügt werden. 
 

1. Wählen Sie ein oder mehrere Objekt(e) aus.  
2. Drücken Sie, während das Objekt / die Objekte ausgewählt ist / sind, Strg + C. 
3. Drücken Sie nun Strg + V, um das Objekt / die Objekte in die Welt einzufügen. Eingefügte Objekte erscheinen 
in der Mitte des Fensters. 

 
Sie können mehrere Objekte markieren, indem Sie eine Auswahl-Box um die gewünschten Objekte ziehen oder indem 
Sie die gewünschten Objekte nacheinander mit der linken Maustaste anklicken, während Sie die Strg-Taste gedrückt 
halten. Diese Objekte können als Gruppe seitlich und vertikal bewegt, sowie um eine zentrale Längsachse rotiert werden.  
 
 
1.4 Spawn-Punkte 
 
 Jetzt haben wir also unsere Feinde. Doch wo erscheinen eigentlich die Spieler in der Welt? Das legen wir durch 
so genannte Spawn-Punkte  fest. An einem solchen Spawn-Punkt betritt der Spieler die Welt, wenn das Spiel beginnt. 
(Der Punkt wird durch eine Figur repräsentiert; diese hat keine Auswirkungen darauf, wie Ihr Charakter später aussehen 
wird.) Spawn-Punkte dürfen nicht mit Respawn-Punkten verwechselt werden. Letztere sind Objekte, an denen ein 
Spieler nach seinem Tod wieder erscheint, falls er sie zuvor aktiviert hat. Es muss in jeder Welt mindestens einen Spawn-
Punkt geben, da sonst kein Charakter die Welt betreten kann. 
  
1.4.1 Platzieren eines Spawn-Punktes 
1) Wählen Sie im rechten Verzeichnis-Fenster den Ordner „Records -> Controls“ aus. 
2) Wählen Sie dort das Objekt „spawnplayer“ aus. 
 Das „spawnplayer” Objekt wird genau wie andere Objekte platziert und bearbeitet. 
3) Klicken Sie auf das Gelände im „Level Edit“ Fenster, um den Spawn-Punkt zu setzen (siehe Sektion 1.3). 

 
 
1.5 Fertigstellen Ihrer Welt und Level  
 
 Nun haben wir also alle Objekte platziert, und es ist an der Zeit, uns der Action innerhalb des eigentlichen Spiels 
zu nähern! Allerdings haben wir vorher noch ein paar Dinge zu erledigen. Im Editor müssen wir noch Pathing Meshes  
und Karten (Maps)  erstellen. Pathing Meshes legen fest, wo und wie sich Spieler und andere Charaktere im Level 
bewegen können. Die „Map“ repräsentiert in diesem Fall das Bild, welches in der Minimap des User-Interfaces im Spiel 
angezeigt wird. Beides wird im Layout Mode erstellt. Jedes Mal, wenn Sie das Gelände verändern oder Gegenstände 
bewegen, müssen Sie die Pathing Meshes und Karten neu anlegen. 
 
1.5.1 Erstellen eines Pathing Mesh 
1) Wechseln Sie in den Layout Mode, indem Sie die Registerkarte „Layout Mode“ am Unterrand des Fensters wählen. 
2) Wählen Sie in der Menüleiste den Menüpunkt „Build -> Rebuild All Pathing” aus. 



 
 Ein Ladebalken erscheint und zeigt Ihnen an, wann der Prozess in etwa fertig sein wird. 
3) Klicken Sie auf „OK”, um das „Level Progress“ Fenster zu schließen. 
 
1.5.2 Erstellen von Karten 
1) Sie müssen sich im Layout Mode befinden. Wählen Sie dort in der Menüleiste „Build -> Rebuild All Maps“ aus. 
 Ein Ladebalken erscheint und zeigt Ihnen an, wann der Prozess in etwa fertig sein wird. 
 
1.5.3 Änderungen speichern  
1) Wählen Sie in der Menüleiste „File -> Save All“ aus. 
 Wenn Sie alle Änderungen an der Welt und ihren Leveln gespeichert haben, ist die Arbeit im Editor erledigt. Es 
gibt jedoch noch immer einige Schritte zu erledigen.  
 
 
1.6 Erstellen einer Karte 
 
 Die nächsten paar Schritte schließen den Art Manager von Titan Quest mit ein. Dieser wird meist benutzt, um 
Rohdaten (.wrl, .jpg) in für das Spiel optimierte Formate zu konvertieren (.tex, .map). Titan Quest importiert Gelände-
Daten aus dem Datei-Typ .map. Um eine solche Datei zu erstellen, muss der Designer .wrl und .lvl Dateien in eine Karte 
integrieren. 
 Da auf diese komplizierten Schritte erst später eingegangen wird, wurde bereits eine .map Datei beigefügt, die die 
.wrl und .lvl Daten enthält, die wir gerade im Editor benutzt haben. 
 
Beispiel 1.6.1 Erstellen einer .map Datei  
 Als erstes müssen Sie den Ordner aufsuchen, der die .map Datei enthält.  
1) Öffnen Sie den Art Manager und klicken Sie in der Menüleiste auf „Mod -> Select -> Tutorial01”. 

 
2) Klicken Sie auf die „Assets“ Registerkarte unter dem Verzeichnis-Fenster (Directory Pane) . Erweitern Sie den Ordner 
„Tutorial01\assets“ und klicken Sie auf den Ordner „Maps”. Klicken Sie nun auf „Tutorial-Basic_Navigation.map” im 



rechten Ordner-Fenster (Folder Pane) . 

 
 
3) Klicken Sie in der Menüleiste auf „Build -> Build “. 
 In dem Fenster am Unterrand des Monitors regt sich nun einige Aktivität, die anzeigt, dass der Art Manager die 
.map Daten bearbeitet. Wenn er damit fertig ist, wird Ihnen die Gesamtzeit zum Erstellen angezeigt. 

 
 
 
1.7 Spielen Ihrer Karte  
 
 Es ist geschafft, unsere Karte ist fertig. Also ab zum Spiel und ausprobieren! 
 
 
1.7.1 Spielen einer selbst erstellten Karte 
1) Starten Sie Titan Quest. 
2) Wählen Sie Eigenes Spiel spielen  im Hauptmenü. 
3) Wählen Sie „tutorial01 ~ tutorial-basic_navigation.map” aus der Liste aus. 
4) Klicken Sie nach dem Erstellen bzw. Auswählen Ihres Charakters auf Start , um Ihre Karte zu spielen. 
 
 
Zur Erinnerung 
• Sie müssen immer mindestens einen Spawn-Punkt auf Ihrer Karte haben. 
• Erstellen Sie Pathing Meshes und Karten, wenn Sie Änderungen an einem von beiden vorgenommen haben. 
• Nachdem Sie Ihre Karte gespeichert haben, müssen Sie auch Ihr Mod neu speichern, da die Änderungen sonst im Spiel 
nicht wirksam werden. 



Tutorial 2: Der Art Manager  
 
 Der Art Manager dient dazu, Rohdaten in ein Format umzuwandeln, das von Titan Quest gelesen werden kann. 
Stellen Sie sich den Editor und Quest Editor als Schüsseln vor, in denen verschiedene Zutaten zusammen gemixt 
werden; der Art Manager ist dann der Ofen, in dem die Zutaten zu einem leckeren Kuchen gebacken werden. Daten aus 
den Editoren werden Quelldaten  (Source Data)  genannt. Der Art Manager wandelt diese Quelldaten nun in so genannte 
Güter (Assets) um. 
 Eine weitere Funktion des Art Managers ist das Anlegen von Datenbank-Einträgen. Durch sie ist es möglich, 
Güter so in Objekte umzuwandeln, dass der Spieler in Titan Quest mit ihnen interagieren kann. 
 
2.0.1 Sich im Art Manager zurechtfinden  
1) Öffnen Sie den Art Manager. 
 Das linke obere Fenster ist das Verzeichnis-Fenster (Directory Pane). Es enthält eine Übersicht der 
verschiedenen Ordner, in denen sich Quelldaten, Güter- und Datenbank-Dateien befinden. Unter dem Verzeichnis-
Fenster liegen Registerkarten, mit denen Sie zwischen Quelldaten (Sources), Gütern (Assets) und Datenbanken 
(Databases) wählen können. Die jeweiligen Dateien des ausgewählten Ordners werden im rechten oberen Ordner-
Fenster (Folder Pane) angezeigt. 

 
 Unter dem Verzeichnis- und Ordner-Fenster befindet sich das Status-Fenster. Dort wird der Fortschritt des 
gerade ablaufenden Prozesses im Art Manager angezeigt. 
 
 
2.1 Erstellen von Gütern im Art Manager  
Quelldateien, die Sie im Arbeitsordner des Mods oder einem seiner Unterordner gespeichert haben, sollten automatisch 
in der Sources-Registerkarte erscheinen. Wenn Sie dieses Mod im Editor auswählen und bearbeiten, werden die Daten 
automatisch im richtigen Ordner abgelegt. 
 
2.1.1 Erstellen von Gütern 
Sie können Güter automatisch erstellen lassen. Dazu müssen Sie in der Sources -Registerkarte mit der rechten 
Maustaste auf die gewünschte Quest- oder World-Datei klicken. Im daraufhin erscheinenden Menü müssen Sie einfach 
nur noch auf „Auto-Create Asset” klicken. Dadurch wird automatisch ein Gut mit demselben Namen wie die Quelldatei in 
der „Assets“ Registerkarte erstellt. 
 
1) Öffnen Sie den Art Manager und wählen Sie „Tutorial02”, indem Sie in der Menüleiste auf „Mod -> Select -> Tutorial02“ 



klicken. 
2) Erweitern Sie den Ordner „Tutorial02\source“. 
3) Wählen Sie den Ordner „Quests” aus. Klicken Sie mit der rechten Maustaste auf „Tutorial-Save_The_Village.qst” und 
wählen Sie „Auto-Create Asset”. 

 
4) Sie werden nun nach dem Namen des Gutes gefragt (der korrekte Name sollte bereits automatisch ausgewählt sein). 
Klicken Sie auf „OK”. Nun wird automatisch ein Gut mit demselben Namen wie die Quelldatei in der „Assets“ 
Registerkarte erstellt. 
5) Von den „Quests“ nun zu den Karten. Klicken Sie mit der rechten Maustaste auf die .wrl-Datei und wählen Sie „Auto-
Create Asset“. Die Datei wird mit all ihren zugehörigen Level-Dateien in ein .map-Asset integriert. 
 
Sie können Güter auch manuell erstellen. 
 
1) Klicken sie auf die „Assets“ Registerkarte. 
2) Klicken Sie mit der rechten Maustaste auf „Tutorial02\assets“, um einen Ordner mit demselben Namen wie jener der 
Quelldatei zu erstellen. Sollte dieser schon existieren, entfällt der Schritt. 
3) Wählen Sie nun den Ordner, in dem sich unter der Sources-Registerkarte die Quelldatei befindet, aus und klicken Sie 
mit der rechten Maustaste in das Ordner-Fenster.   
4) Klicken Sie auf „New” im Menü und wählen Sie anschließend den Typ von Gut, den Sie erstellen wollen. Daraufhin 
können Sie die Quelldatei manuell auswählen, und die Güter-Datei wird erstellt. 

 
 
 
 



2.2 Erstellen von Dateien im Art Manager  
Um Änderungen auch im Spiel zu sehen, müssen Sie ein Gut erstellen. Dabei werden die veränderten Quelldateien und 
Datenbank-Einträge in ein Format umgewandelt, das von Titan Quest gelesen werden kann.  
Falls Sie mehrere Änderungen vorgenommen haben, ist es in der Regel ratsamer, Ihr gesamtes Mod neu zu erstellen – 
das dauert ja nicht allzu lange. Wählen Sie in der Menüleiste „Build -> Build”. Noch ein wichtiger Hinweis: Schließen Sie 
den Art Manager nicht, bevor Sie mit dem Erstellen fertig sind! 
 
Sie können Güter, Datenbank-Einträge und Verzeichnisse auch direkt in der jeweiligen Registerkarte erstellen. Um das zu 
tun, klicken Sie einfach mit der rechten Maustaste auf den jeweiligen Ordner oder die Datei und wählen Sie „Build“ aus 
dem Menü aus. 

 
 



Tutorial 3: Grundlagen zum Terrain 
 
 Im letzten Tutoral haben wir also gelernt, wie man ein Level erstellt, das in Titan Quest spielbar ist. Außerdem 
haben wir gelernt, wie man Level anpasst, indem man Charaktere und Szenerie ändert. In diesem Tutorial werden wir nun 
lernen, wie das Gelände geformt wird, um unsere eigene, persönliche Welt zu kreieren. 
 
3.0.1 Die Umwelt erkunden 
1) Öffnen Sie den Editor. 
2) Wählen Sie im Mod Menü „Tutorial03” aus. 
3) Öffnen Sie „Tutorial-Basic_Terrain_Terrain.lvl“ im Editor Mode. 
 
 
3.1 Das Heben/Senken-Werkzeug 

 
 Das erste und grundlegendste Form-Werkzeug ist das Heben/Senken-Werkzeug . Es wird verwendet, um das 
Gelände zu erhöhen bzw. abzusenken.  
 
3.1.1 Das Heben/Senken-Werkzeug benutzen 
1) Wählen Sie das Heben/Senken-Werkzeug aus der Werkzeugleiste aus. 
2) Bewegen Sie die Maus über das „Level Edit“ Fenster. 
 Es werden nun zwei konzentrische Kreise mit einem kleinen X in der Mitte auf das Gelände projiziert. Dieses 
repräsentiert die Werkzeugspitze und zeigt an, wo die Veränderungen wirksam werden. 
3) Klicken und halten Sie die linke Maustaste über dem Gelände. 
 Unter der Werkzeugspitze erhebt sich ein Hügel. 
4) Klicken Sie die linke Maustaste und ziehen Sie die Maus über das Gelände. 
 Eine Düne erhebt sich entlang der Strecke, die Sie mit der Maus abgefahren sind. 
5) Halten Sie nun die Hochstell-Taste gedrückt, während Sie erneut die linken Maustaste drücken und die 
Werkzeugspitze über das Gelände ziehen. 
 Das Gelände unter der Werkzeugspitze senkt sich jetzt ab.  

 
 
 
3.2 Eigenschaften der Werkzeugspitze   
 Der Effekt vieler Werkzeuge lässt sich in den Werkzeugspitzen-Eigenschaften modifizieren. Ist dies der Fall, 
werden die Eigenschaften im „Brush Properties“ Fenster rechts im Bildschirm angezeigt. Alle Werkzeugspitzen-
Eigenschaften lassen sich verändern, indem man neue Werte in die jeweiligen Felder einträgt. Die drei Standard-
Eigenschaften sind Radius , Stärke (Strength)  und Geschwindigkeit (Speed) . 
 
3.2.1 Werkzeugspitzen-Radius 
 Die erste Eigenschaft ist der Radius , der die Fläche verändert, die die Werkzeugspitze abdeckt. 
1) Geben Sie einen neuen Wert in das Feld für den Radius im „Brush Properties“ Fenster ein. 
 Die Größe der Kreise auf dem Gelände sollte sich ändern. 
 Der Radius der Werkzeugspitze kann auch mit Hotkeys verändert werden. 
2) Drücken Sie die „ß“ Taste. 



 Der Radius der Werkzeugspitze verkleinert sich. 
3) Drücken Sie die „´“ Taste rechts neben „ß“. 
 Der Radius der Werkzeugspitze vergrößert sich. 
 
3.2.2 Werkzeugspitzen-Stärke 
 Die zweite Eigenschaft ist die Werkzeugspitzen-Stärke (Strength) . Sie beschreibt, wie stark das Gelände am 
Rand der Werkzeugspitze verändert wird. Eine niedrige Stärke verändert das Gelände hauptsächlich in der Mitte der 
Werkzeugspitze, während eine große Stärke das Gelände fast gleichmäßig über die gesamte Werkzeugspitzen-Fläche 
verändert. 
1) Wählen Sie das Heben/Senken-Werkzeug aus. 
2) Geben Sie als Wert für die Stärke im „Brush Properties“ Fenster 10% ein. 
3) Drücken und halten Sie die linke Maustaste auf einen Punkt im Gelände. 
 Das Gelände steigt in der Mitte der Werkzeugspitze steil an, wohingegen es zum Rand hin beinahe unverändert 
bleibt. 

 
4) Geben Sie nun als Wert für die Stärke im „Brush Properties“ Fenster 100% ein. 
5) Drücken und halten Sie die linke Maustaste erneut auf einen Punkt im Gelände. 
 Das Gelände sollte sich nun fast gleichmäßig erheben. 

 
 
 
 
3.2.3 Werkzeugspitzen-Geschwindigkeit  
 Die letzte Eigenschaft, die Geschwindigkeit (Speed) , beschreibt, wie schnell das Gelände erhöht oder 
abgesenkt wird. 
1) Wählen Sie das Heben/Senken-Werkzeug aus. 
2) Geben Sie als Wert für die Geschwindigkeit im „Brush Properties“ Fenster 10 ein. 



3) Drücken und halten Sie die linke Maustaste auf einen Punkt im Gelände. 
 Es dauert einige Sekunden, bevor sich das Gelände merklich verändert. 
4) Geben Sie nun als Wert für die Geschwindigkeit im „Brush Properties“ Fenster 500 ein. 
5) Drücken und halten Sie die linke Maustaste erneut auf einen Punkt im Gelände. 
 Ein großer Berg erhebt sich diesmal in kürzester Zeit. 
 
 
3.3 Das Unruhe-Werkzeug 

 
 Das nächste Werkzeug, mit dem wir uns beschäftigen, ist das Unruhe-Werkzeug . Es sorgt dafür, dass unter der 
Werkzeugspitze Erhebungen und Senkungen entstehen. Dadurch kann das Gelände etwas aufgeraut werden und 
dadurch natürlicher erscheinen. Sie können erneut die oben beschriebenen drei Standard-Werkzeug-Eigenschaften 
anpassen. 

 
 
 
3.4 Das Glätten-Werkzeug  

 
 Kommen wir nun zum Glätten-Werkzeug . Durch Glätten können Sie das Gefälle unter der Werkzeugspitze 
angleichen und an das umliegende Gelände anpassen. Das ist hilfreich, um hügeliges Gelände zu (Sie werden es 
erraten…) glätten. Es stehen Ihnen wiederum die Standard-Eigenschaften Radius, Stärke und Geschwindigkeit zur 
Verfügung. 

 
 
3.5 Das Plateau-Werkzeug 



  
 Als nächstes kommt das Plateau-Werkzeug zum Einsatz. Es hebt das gesamte Gelände unter der 
Werkzeugspitze gleichmäßig zu einem Plateau auf einer vorgegebenen Höhe. 

Zusätzlich zu Radius, Stärke und Geschwindigkeit hat das Plateau-Werkzeug als weitere Eigenschaft die Höhe 
(Height) . Sie legt fest, um wie viel das Gelände angehoben werden soll. Eine Art, dies zu verändern, ist, den 
gewünschten Wert in das zugehörige Feld zu tippen. 
 
3.5.1 Das Plateau-Werkzeug benutzen  
1) Wählen Sie das Plateau-Werkzeug aus. 
2) Geben Sie als Wert für die Höhe im „Plateau Properties“ Fenster 10 ein. 
3) Klicken Sie die linke Maustaste und ziehen Sie die Maus über das Gelände. 
 Ein Plateau erhebt sich entlang der Strecke, die Sie mit der Maus abgefahren sind. 
 Die Höhe des Plateaus kann auch exemplarisch an einem Punkt im Gelände festgelegt werden. 
4) Bewegen Sie die Werkzeugspitze mit dem Zentrum an eine Stelle, die etwa auf halber Höhe des Plateaus liegt. 
5) Drücken und halten Sie die Hochstell-Taste. 
6) Klicken Sie mit der linken Maustaste. 
 Der Wert der Eigenschaft Höhe im „Plateau Properties” Fenster nimmt den Wert des Punktes an, auf den Sie 
zuvor geklickt haben. 
 Die Höhe kann auch visuell eingestellt werden. 
7) Drücken und halten Sie die Strg-Taste. 
8) Bewegen Sie die Maus hoch und runter. 
 Ein Drahtmodell-Zylinder gibt Ihnen eine visuelle Darstellung der Höhe oder Tiefe, die das Plateau annehmen 
wird.  

 
 
 
3.6 Das Relative Plateau-Werkzeug 

 
 Es folgt das Relative Plateau-Werkzeug . Es hebt die gesamte Fläche unter der Werkzeugspitze um einen 
bestimmten Wert. Das ist hilfreich, wenn Sie beispielsweise ein gelungenes Gelände erschaffen haben, Ihnen aber klar 
wird, dass Sie das ganze 10 Meter höher brauchen. So müssen Sie also nicht das Heben/Senken-Werkzeug benutzen, 
um alles einzeln 10 Meter anzuheben und laufen dabei Gefahr, die Form des Geländes zu verlieren. Stattdessen können 
Sie das Relative Plateau-Werkzeug benutzen und die gesamte Fläche auf einmal anheben. 
 Es gibt zusätzlich zu den Standard-Eigenschaften noch eine weitere namens Offset (Versatz) . Sie legt fest, wie 
hoch das relative Plateau sein wird im Vergleich zum ursprünglichen Wert. 



 
 
 
3.7 Das Terrain-Kopieren/Einfügen-Werkzeug  

 
 Das Terrain-Kopieren/Einfügen-Werkzeug  eignet sich gut, wenn Sie zwei ähnliche Bereiche in Ihrer Welt 
wünschen, das Gelände jedoch nicht zweimal formen möchten.  
 
3.7.1 Das Terrain-Kopieren/Einfügen-Werkzeug  benutzen  
1) Wählen Sie das Terrain-Kopieren/Einfügen-Werkzeug aus. 
 Wenn Sie das Werkzeug ausgewählt haben, wird Ihnen auffallen, dass sich um die übliche Werkzeugspitze noch 
ein zusätzliches Quadrat befindet. Wie bei allen anderen Werkzeugen können Sie die Größe der Werkzeugspitze mit den 
Tasten „ß“ bzw. „´“ verändern. 
2) Verändern und bewegen Sie die Werkzeugspitze so, dass sie das gesamte Gelände, welches Sie kopieren möchten, 
beinhaltet. 
3) Klicken Sie nun mit der linken Maustaste. 
 Die Werkzeugspitze sollte nun ein Geister-Image des Geländes, das Sie gerade kopiert haben, annehmen. 
 Falls nötig können Sie das Geister-Image nun drehen. 
4) Drücken Sie „,“ oder „.“, um das Geister-Image gegen den Uhrzeigesinn, respektive im Uhrzeigersinn zu drehen. 
5) Bewegen Sie die Werkzeugspitze als nächstes zu der Stelle, an der Sie das kopierte Gelände einfügen wollen. 
6) Klicken Sie mit der linken Maustaste, um das kopierte Gelände einzufügen. 
7) Um das Geister-Terrain-Image zu löschen, drücken Sie die Leertaste. 

 
 
 
 



 
3.8 Das Rampen-Werkzeug 

 
 Das Rampen-Werkzeug  bietet die Möglichkeit, eine glatte Steigung zwischen zwei unterschiedlich hoch 
gelegenen Punkten zu schaffen. 
 
 Um eine Rampe zu bauen, klicken Sie einfach auf einen Punkt im Gelände und ziehen Sie die Maus bei 
gehaltenem Knopf auf einen zweiten Punkt. Der Editor schafft daraufhin automatisch eine glatte Steigung zwischen 
diesen beiden Punkten. (Damit eine sichtbare Steigung entsteht, müssen die Punkte natürlich auf unterschiedlich hohen 
Niveaus liegen.) 
 Die Breite der Rampe kann im „Ramp Properties” Fenster auf der rechten Seite eingestellt werden. 

 
 
 
3.9 Das Textur-Werkzeug 

 
 Zusätzlich zum Formen der Landschaft können wir ihr noch eine Textur bzw. Oberflächenstruktur und damit mehr 
Charakter verleihen. 
 
3.9.1 Hinzufügen einer Textur 
1) Wählen Sie zunächst das Texturen-Werkzeug  aus. 
 Jede Oberflächenstruktur stellt eine eigene Schicht dar, die jeweils eine eigene Deckkraft (Opacity) hat. Bereiche, 
die mit einer Textur mit niedriger Deckkraft gestrichen werden, zeigen mehr von den darunter liegenden Schichten. 
Welche Textur-Schichten Sie gerade benutzen, wird rechts im „Texture Layers“ Fenster angezeigt. Dort befindet sich eine 
Liste mit allen Schichten, die Sie übereinander streichen. Dabei wird die oberste Schicht in der Liste als erste 
aufgetragen. Befinden sich also beispielsweise in der Liste von oben nach unten Felsen, Erde und Gras, so wird zuerst 
die Felsen-Schicht gesetzt, dann darauf die Erde und ganz zuoberst das Gras. 
2) Um eine Schicht hinzuzufügen, klicken Sie auf den „Add Layer“ Knopf unter der Liste. 
 Daraufhin öffnet sich das „Texture Picker ” Fenster. 



 
3) Im Verzeichnis-Fenster (Directory Pane) auf der linken Seite sehen Sie die Ordner mit den Texturen. 
 Wenn Sie einen Ordner anklicken, erscheint rechts im Ordner-Fenster (Folder Pane) eine Auflistung aller darin 
befindlichen Texturen mit dazugehörigen Thumbnails.  
4) Wählen Sie eine Textur im Ordner-Fenster aus. 
 Es erscheint eine größere Vorschau der Textur in der rechten unteren Ecke des „Texture Picker“ Fensters. 
5) Wenn Ihnen die Textur gefällt, drücken Sie auf „OK“. 
 



 
3.9.2 Malen mit einer Textur-Schicht 
 Gelände-Texturen werden direkt auf das Gelände gemalt. 
1) Wählen Sie das Textur-Werkzeug aus. 
2) Wählen Sie eine Textur-Schicht aus dem „Texture Layers“ Fenster. 
3) Bewegen Sie die Werkzeugspitze über das Gelände. 
4) Klicken Sie mit der linken Maustaste und ziehen Sie die Maus über das Gelände, um es mit der Textur zu versehen. 

 
 Um Texturen ineinander übergehen zu lassen, lässt sich die Deckkraft (Opacity)  im „Texture Opacity“ Fenster 
auf der rechten Seite einstellen. Bei jeder Textur verschwinden gewisse Bereiche beim Regulieren der Deckkraft zuerst; 
so bleibt Kies beispielsweise länger sichtbar als Erde, Blätter werden weniger etc. 
 Sie können die Deckkraft anpassen, indem Sie den Wert im „Texture Opacity“ Fenster durch Bewegen des 
Schiebereglers ändern. Die Deckkraft kann auch mittels der Zahlentasten auf dem Keyboard in 10%-Schritten verändert 
werden. 

 
 



Tutorial 4: Quest-Objekte 
 
 An dieser Stelle wissen wir bereits, wie man eine Welt erschafft, interessante Landschaften kreiert und dem 
Spieler ein paar Feinde entgegen wirft. Was ist nun aber, wenn der Spieler nicht nur Gold und Erfahrungspunkte für das 
Töten von Monstern bekommen soll? Dafür müssen wir Quests  zusammenstellen. Quest-Dateien helfen dabei, sowohl 
die Aktionen zu organisieren, die das Spiel vorantreiben, als auch die Bedingungen, die diese Aktionen in Gang setzen. 
Auslöser können eingesetzt werden, um alles Mögliche zu tun: vom Öffnen einer Tür über das Töten von Gegnern, bis hin 
zur Vergabe von Skill Points. In diesem Beispiel werden wir mit einer einfachen „töte das Monster, das die Leute 
terrorisiert“ Quest arbeiten. Der Spieler fängt an, indem er mit einem Dorfbewohner spricht. Dieser erzählt dem Spieler 
dann, dass er das Monster töten soll. Daraufhin geht der Spieler das Monster töten und kehrt anschließend zum Dorf 
zurück. Dort gibt ihm der Dorfbewohner eine Belohnung. Die Quest und alle dazugehörigen Datenbank-Einträge 
existieren bereits. Alles, was wir jetzt noch tun müssen, ist, die benötigten Objekte in die Karte zu setzen. Die Quest sollte 
nun laufen, sobald ein Spieler unsere Karte spielt. 
 
Setup 
1) Öffnen Sie den Art Manager  
2) Klicken Sie in der Menüleiste auf „Mod -> Select“ und wählen Sie „Tutorial04“ aus. 
3) Klicken Sie in der Menüleiste auf „Build -> Build“. 
 
Jetzt sind die Datenbank-Einträge vom Editor aus verfügbar, und wir können loslegen. 
 
4.0.1 Die Umgebung erkunden 
1) Öffnen Sie den Editor. 
2) Wählen Sie das „Tutorial04” Mod und öffnen Sie „Tutorial-Quest_Objects.wrl“ im Ordner „source -> Maps“. 
 Wir finden eine Welt mit einem ansehnlichen Terrain und einigen Dekorationen vor. Viel wichtiger ist allerdings, 
dass wir ein Quest-Objekt haben, das für die Quest unentbehrlich ist. Dieses Quest-Objekt ist der Dorf-Bewohner. Er ist 
der alte, dicke Mann, der neben seiner Hütte steht. (Sollte dieser nicht vorhanden sein, muss er noch eingefügt werden. 
Sie finden ihn im rechten Fenster unter dem Ordner „npcs“.) Ein anderes unverzichtbares Objekt fehlt uns jedoch. Wenn 
uns der Dorfbewohner nämlich aufträgt, das Monster zu töten, sollten wir lieber dafür sorgen, dass es auch ein Monster 
zum Töten gibt. 
 
4.0.2 Ein Quest-Objekt platzieren 
 Für dieses Tutorial wurde ein spezielles Objekt namens „tutorial-quest_satyr“ kreiert. Er entspricht einem 
„am_peltast_02“-Satyr, mit dem Unterschied, dass dieser besondere Quest-Satyr nötig ist, um die Quest zu erfüllen. 
1) Laden Sie das Level „custommaps\Tutorial04\source\Tutorial-Quest_Objects_Terrain.lvl“. 
2) Wählen Sie das Objekt-Platzierungs-Werkzeug aus. 
3) Erweitern Sie den Ordner „monsters“ und wählen Sie „tutorial-quest_satyr“ aus. (Alle Standard-Titan Quest-Güter sind 
im Verzeichnis „records“ zu finden. Wenn Sie Ihre eigenen Datenbank-Einträge erstellen, werden diese in dem Ordner 
erscheinen, in dem sie kreiert wurden. Der Ordner ist in dem Fall zusätzlich zum Ordner „records“ im rechten Fenster zu 
finden. Wenn Sie Records importieren, sollten Sie sie in Ihr eigenes Verzeichnis verschieben. Andernfalls werden sie 
irgendwo in einem Unterordner eines Unterordners von „records“ zu finden sein.) 
4) Platzieren Sie den „tutorial-quest_satyr“ irgendwo im Level, indem Sie einfach mit der linken Maustaste auf einen Punkt 
in der Karte klicken. 
 Sie können die Erfahrung des Spielers verändern, abhängig davon, wo Sie den Satyr platzieren. So ist es 
beispielsweise vorstellbar, dass sich der Spieler einen Berghang hochkämpfen muss oder im Tal in einen Hinterhalt gerät, 
je nachdem, was Ihnen gefällt. Der Punkt ist hierbei, dass der Auslöser für diese Quest auf einem bestimmten Objekt 
basiert. 
 
4.0.3 Erstellen und Speichern der Karte 
 Vergessen Sie nicht, am Ende des Editierens alles neu zu erstellen und zu speichern. 
1) Erstellen Sie erneut alle Pathing Meshes und Karten, wenn Sie auch nur das Geringste an der Szenerie oder dem 
Gelände verändert haben. 
2) Klicken Sie auf „File -> Save All“ in der Menüleiste des Editors. 
3) Öffnen Sie den Art Manager. 
4) Erstellen Sie „Tutorial-Quest_Objects.map“. 
5) Probieren Sie Ihre Karte nun im Spiel aus.



Tutorial 5: Fortgeschrittenes Terrain 
 
 Als wir uns das letzte Mal mit dem Terrain beschäftigt haben, lernten wir die Grundlagen der Gelände-Formung 
kennen und rundeten das ganze mit Texturen ab. Jetzt wird es richtig abgefahren! Wir werden das Sektor-Malen kennen 
lernen, ebenso wie einige Wasser-Werkzeuge und Bewegungs-Block-Zonen. 
 
5.0.1 Die Umgebung erkunden 
1) Öffnen Sie den Editor. 
2) Wählen Sie das Mod „Tutorial05” aus. 
3) Finden und öffnen Sie „Tutorial-Mountain_Stream_Terrain.lvl“ im Editor Mode.  
 Sie werden feststellen, dass es sich bei dem Level um ein großes Plateau mit kleinen Erhebungen in der Ferne 
handelt. Mit Hilfe von Hochnebel werden wir es wie Bergspitzen aussehen lassen, die in den Himmel ragen. Des Weiteren 
werden Sie einen Graben sehen, der entlang des großen Plateaus in eine Grube läuft. Wir werden daraus einen Fluss 
machen, der in einen Teich mündet. 

 
 
 
5.1 Sektor-Malen 

 
 Fangen wir am besten mit dem Sektor-Mal-Werkzeug  an. Ein Sektor  ist ein Bereich, der die Eigenschaften der 
Welt ändert, wenn sich ein Spieler in ihm befindet. Wir werden die Nebel- und Belichtungs-Eigenschaften der Welt in dem 
Sektor verändern, den wir in diesem Beispiel erstellen. 
 
5.1.1 Eine neue Sektor-Schicht Kreieren  
1) Fangen wir an, indem wir das Sektor-Mal-Werkzeug auswählen. 
 Sie müssen im Hinterkopf behalten, dass die Nebel-Effekte nicht nur dort auftauchen, wo der Sektor bemalt 
wurde. Vielmehr erscheinen sie überall, sobald sich der Spieler im Sektor aufhält. Wir wollen, dass im Hintergrund Wolken 
auftauchen, wenn der Spieler auf dem Haupt-Plateau umherläuft. Dafür müssen wir ausschließlich den Sektor auf dem 
Haupt-Plateau bemalen. 
2) Klicken Sie im rechten „Sector Paint Options” Fenster auf „New“, um eine neue Nebel/Belichtungs-Sektor-Schicht zu 
schaffen. 
 Ein neuer Sektor-Stil namens „New Sector Style” sollte erscheinen. An dieser Stelle empfiehlt es sich, dem neuen 
Sektor-Stil einen etwas deskriptiveren Namen zu geben. 
3) Tippen Sie in die „Style Name“ Textbox im „Sector Paint Options” Fenster den Namen „Mountain Fog” ein. 



 
 
5.1.2 Wie Sektoren funktionieren 
 Schreiten wir zu einer kleinen Demonstration der Funktionsweise von Sektoren. 
1) Wählen Sie den Schicht-Stil „Mountain Fog“. 
2) Benutzen Sie die Maus wie einen Pinsel und klicken Sie mit der Maustaste irgendwo in das Gelände. 
 In der Mitte des Fensters werden Sie eine kleine schwarze Kugel sehen. Dies ist das Objekt, das vom Editor 
benutzt wird, um festzustellen, in welchem Sektor Sie sich befinden. 
3) Bewegen Sie sie Kamera so, dass sich die schwarze Kugel gerade außerhalb des Terrains befindet, das Sie angemalt 
haben. 
 Rechts im „Fog/Lighting Options” Fenster sehen Sie in der „Height Fog” Unterteilung einen „Density” 
Schieberegler. 
4) Ziehen Sie diesen „Density” Schieberegler auf einen Wert um 0.50. 
5) Bewegen Sie die Kamera zurück, so dass sich die schwarze Kugel wieder in dem Sektor befindet, den Sie angemalt 
haben. 
 Sie werden bemerken, dass sich das Fenster mit einem halb-transparenten Nebel füllt. 

 
6) Bewegen Sie die Kugel wieder außerhalb des Sektors. 
 Der Nebel sollte verschwinden. Derselbe Effekt tritt im Spiel auf. Wenn der Charakter in den Sektor läuft, 
erscheinen die Nebel-Effekte, verlässt er den Sektor, verschwindet auch der Nebel. 

 
 
5.1.3 Eine Nebel-Schicht malen 
 Da wir wollen, dass der Nebel im Hintergrund erscheint, sobald der Spieler das Plateau betritt, sollten wir das 
gesamte Plateau als Nebel-Sektor festlegen. 
1) Wählen Sie die Sektor-Schicht aus, die Sie gerade angelegt haben. 
2) Markieren Sie das gesamte Plateau als Nebel-Sektor. 
 Jetzt setzen die Nebel-Effekte ein, sobald der Spieler das Plateau betritt. So schön es allerdings auch ist, überall 
Nebel zu haben, wenn wir auf dem Berg stehen, so wäre es doch noch schöner, wenn wir den Nebel so einstellen 
könnten, dass die einzelnen Plateaus aus dem Nebel ragen. 
 Dazu benötigen wir Hochnebel . Durch die Benutzung von Hochnebel erschaffen wir einen Nebel, der graduell 
von einer festgelegten Dichte auf der einen Höhe in vollständige Durchsichtigkeit auf einer anderen Höhe übergeht. 
 Suchen Sie das „Fog/Lighting Options” Fenster auf der rechten Seite. 



3) Bewegen Sie im „Depth Fog” Bereich den „Density” Schieberegler auf 0.00. 
4) Finden Sie den „Density” Schieberegler im „Height Fog” Bereich des „Fog/Lighting Options“ Fensters. 
5) Schieben Sie ihn 0.99. 
6) Setzen Sie den Wert im „Bottom Height” Kästchen auf 1. 
7) Setzen Sie den Wert im „Top Height“ Kästchen auf 10. Der Nebel wird nun von 99% Dichte auf Höhe von 1 zur totalen 
Transparenz auf Höhe von 10 übergehen. Es wird dann so erscheinen, als ob die Plateaus in der Ferne in den Wolken 
verschwänden, während der Spieler durch den Sektor läuft. 

 

 
 
 
5.2 Das Wasser-Werkzeug 

 
 Nachdem wir nun die Wolken fertig gestellt haben, wollen wir uns dem Teich widmen. 
 
5.2.1 Einen neuen Wasser-Typ kreieren 
1) Wählen Sie das Wasser-Werkzeug  aus. 
 Ebenso wie bei den Terrain-Texturen müssen wir zunächst einen neuen Wasser-Typ anlegen. 
2) Klicken Sie im rechten „Water Types” Fenster auf „Add“. 
 Ein neuer Wasser-Typ wird angelegt und automatisch ausgewählt. 
3) Machen Sie einen Doppelklick auf „newWaterType”. 
 Es öffnet sich das „Water Type Editor” Fenster. 
4) Geben Sie „Standard Water” im Feld „Name“ ein. 
5) Klicken Sie auf „OK“. 
 
5.2.2 Das Wasser auftragen  
 Ähnlich der Höhe des Plateaus wird Wasser in einer bestimmten Tiefe aufgetragen. Sie wird auch auf gleiche 
Weise ermittelt wie die Höhe beim Plateau. 
1) Halten Sie die Hochstell-Taste gedrückt und klicken Sie mit der linken Maustaste etwa auf halber Höhe des felsigen 
Flussufers. 
 Die Wassertiefe wird nun auf den Wert der Position eingestellt, auf die Sie gerade geklickt haben. Sie können die 
Wassertiefe auch verändern, indem Sie die Strg-Taste gedrückt halten und die Maus nach oben oder unten bewegen. 
2) Klicken Sie mit der linken Maustaste und ziehen Sie die Maus über das Gelände, das mit Wasser bedeckt werden soll. 
Füllen Sie vorerst nur die Grube mit Wasser auf. Für den Graben werden wir gleich ein spezielles Fluss-Werkzeug 
benutzen. 
3) Um Wasser-Schichten wieder zu entfernen, wählen sie im rechten „Water Types“ Fenster einfach „None“ aus und 
malen Sie anschließend über die Bereiche, in denen sich kein Wasser befinden soll. 



 
 
5.3 Das Fluss-Werkzeug 

 
5.3.1 Einen Fluss anlegen 
 Jetzt, wo wir einen Teich haben, sollten wir gleich noch den Bergfluss anlegen, der ihn speist.  
1) Wählen Sie das Fluss-Werkzeug aus. 
 Das Fluss-Werkzeug ist ein bisschen komplizierter zu benutzen, da wir diesmal nicht direkt malen, sondern 
stattdessen Punkte setzen, denen der Flussverlauf folgen soll. Jeder dieser Kontrollpunkte  hat „Bezier-Griffe “, die 
festlegen, wie weit die Kurve ist, die der Fluss beim Annähern an die Kontrollpunkte beschreibt. 
2) Wählen Sie den Wasser-Typ. 
 Wenn Sie keinen Wasser-Typ ausgewählt haben, können Sie auch keine Kontrollpunkte setzen. Ggf. müssen Sie 
erst einen neuen Wasser-Typ anlegen, um das Fluss-Werkzeug benutzen zu können. Sie sollten beispielsweise auch 
einen neuen Wasser-Typ kreieren, wenn Sie wollen, dass es in eine unterschiedliche Richtung fließt als andere 
Wasserflächen. 
3) Drücken und halten Sie die Hochstell-Taste gedrückt, um in den Punkt-Kreations-Modus zu gelangen. 
4) Setzen Sie einen Kontrollpunkt durch Klicken mit der linken Maustaste, während Sie die Hochstell-Taste noch immer 
gedrückt halten. 
5) Um die Bezier-Griffe zu verlängern, halten Sie die linke Maustaste gedrückt und ziehen Sie die Kurve in den 
gewünschten Radius. 
6) Um einen weiteren Punkt zu setzen, lassen Sie den linke Mausknopf los. Klicken Sie nun erneut mit der linken 
Maustaste, diesmal an der Stelle, an der Sie den neuen Kontrollpunkt wünschen. 
7) Durch Drücken der Rücktaste löschen Sie den jeweils als letztes gesetzten Kontrollpunkt. 
8) Platzieren Sie nun eine Reihe von Punkten entlang dem Verlauf des Grabens, so dass der Fluss zwischen den 
Flussufern verläuft. Sie können das Gelände anschließend anpassen, um eine gute Verbindung zwischen dem Fluss und 
den Ufern herzustellen. 
9) Um einen weiteren Fluss anzulegen, lassen Sie die Hochstell-Taste los und klicken Sie irgendwo in das Gelände. 
 Sie können nun ganz normal Kontrollpunkte für den neuen Fluss setzen. 



 
 
5.3.2 Einen Fluss bearbeiten  
 Nach dem Setzen von Kontroll- und Kurvenpunkten können diese nachträglich verschoben werden. 
1) Bewegen Sie den Mauszeiger zum Zentrum eines Kontrollpunktes. 
 Der Mauszeiger verwandelt sich in einen Vier-Wege-Pfeil. 
2) Verschieben Sie den Kontrollpunkt durch Drag and Drop. 
3) Bewegen Sie den Mauszeiger zum oberen oder unteren Rand des Kontrollpunktes. 
 Der Mauszeiger verwandelt sich in einen Zwei-Wege-Pfeil nach oben und unten. 
4) Verändern Sie die Tiefe des Flusses durch Drag and Drop. 
5) Bewegen Sie den Mauszeiger zum linken oder rechten Rand des Kontrollpunktes. 
 Der Mauszeiger verwandelt sich in einen Zwei-Wege-Pfeil nach links und rechts. 
5) Verändern Sie die Breite des Flusses an diesem Punkt durch Drag and Drop. 
6) Wählen Sie einen Kontrollpunkt aus und bewegen Sie den Mauszeiger zu einem der Bezier-Griffe. 
 Der Zeiger sollte sich in einen kreisförmigen Pfeil verwandeln. 
7) Verschieben Sie die Bezier-Griffe durch Drag and Drop. 
 Der Flussverlauf ändert sich, wenn die Bezier-Griffe bewegt oder verlängert werden. 
8) Zum Verändern der Breite des Flusses können Sie auch die Tasten „ß“ und „´“ verwenden, während Sie einen 
Kontrollpunkt angewählt haben. 
 Durch cleveres Positionieren der Kurvenpunkte lässt sich die Anzahl der benötigten Kontrollpunkte oft reduzieren. 
 
 
5.4 Das Bewegungs-Block-Zonen-Werkzeug 

 
 Das letzte Werkzeug, mit dem wir uns in diesem Tutorial beschäftigen wollen, ist das Bewegungs-Block-Zonen-
Werkzeug . Als Designer verwendet man dieses Tool, um Bereiche festzulegen, die der Spieler nicht betreten soll.  
 
5.4.1 Eine Bewegungs-Block-Zone festlegen  
 Dieses Werkzeug wird genauso verwendet wie das Textur-Werkzeug. 
1) Klicken Sie mit der linken Maustaste und bewegen Sie die Maus im „Level Edit“ Fenster über die Bereiche, die der 
Spieler nicht betreten soll. 
2) Die Bewegungs-Block-Zonen-Werkzeugspitze kann mit den Tasten „ß“ und „´“ vergrößert bzw. verkleinert werden. 
3) Da wir nicht wollen, dass sich ein Spieler von den Klippen am Rand der Karte stürzt, sollten Sie nun alle Kanten des 
Plateaus mit Bewegungs-Block-Zonen versehen. 



 
 Das war es auch schon wieder. Vergessen Sie nicht, Ihre Pathing Meshes neu zu erstellen, da das Bewegungs-
Block-Zonen-Werkzeug diese verändert (siehe Sektion 1.5.1). Speichern Sie also einfach im Editor und erstellen Sie im 
Art Manager wie gewohnt.



Tutorial 6: Dungeons und Raster 
 
 Bis jetzt waren alle Bereiche, mit denen wir uns beschäftigt haben, im Freien gelegen. Sie spielen im Terrain . 
Titan Quest kennt auch eine zweite Art von Bereichen namens Raster . Ein Raster ist im Grunde genommen ein Brett mit 
Kacheln, bei dem Boden und Wände bemalt werden können. Raster sind ideal für innen liegende, Dungeon-artige 
Bereiche. Raster haben drei Haupt-Komponenten: Boden , Wände und Features . 
 Als Boden wird jeder Bereich bezeichnet, auf dem der Spieler laufen darf. Wände können durch das gesamte 
Level gezogen werden, um so ein Labyrinth für den Spieler zu erstellen. Features sind weitere Aspekte, die mit Boden 
und Wänden verbunden werden können. Sie beinhalten oft Portale, durch die ein Raster mit anderen Regionen 
verbunden ist. Wir werden später in diesem Tutorial intensiver auf Portale eingehen. 
 
6.0.1 Die Umgebung kennenlernen 
1) Öffnen Sie den Editor. 
2) Wählen Sie das Mod „Tutorial06“. 
3) Finden und öffnen Sie „Tutorial-Dungeon_Crawl_Grid.lvl“ im Editor Mode. Sie werden feststellen, dass es bereits ein 
Stück Dungeon-Boden zu sehen gibt. Auch existieren schon einige Wände, die den Bereich in Räume unterteilen. 
 
 
6.1 Raster-Systeme 
6.1.1 Wählen eines Raster-Systems 
1) Wählen Sie das Raster-Bearbeitungs-Werkzeug aus. 

 
 Eine violette Ebene mit einem darauf befindlichen Raster wird nun sichtbar. Dies zeigt die Ausdehnung des Level-
Rasters an. Boden- und Wand-Kacheln können nicht außerhalb der Level-Grenzen verlegt werden. 
 Der erste Schritt, wenn man ein Raster anlegt, ist das Wählen eines System s für das Raster. Ein System ist wie 
ein ästhetisches Konzept für Ihr Raster. Jedes hat seine eigenen Wände, Böden und Features, die jeweils automatisch 
mit anderen Kunst-Gütern ausgetauscht werden können, indem man das Raster-System wechselt. 
 Versuchen wir doch also, das System dieses Dungeons zu ändern. 
2) Klicken Sie auf den Knopf, der sich rechts vom „System“ Feld im „Grid Types“ Fenster befindet. 
 Daraufhin erscheint ein Browser-Fenster mit allen verfügbaren Raster-Systemen. 
3) Wählen Sie „records\underground\egypt\egyptcrypt.dbr” aus und klicken Sie auf „OK“. 

 
 Der Dungeon verändert nun sein Aussehen von einer Reihe natürlich anmutender, grüner Mauern zu braunen 
Steinmauern. (Sollte sich nichts verändern, war das oben gewählte System ggf. schon eingestellt.) 

 
 
 
6.2 Ein Raster bemalen 
 
6.2.1 Den Boden malen 
 Zunächst einmal werden wir zusätzliche Bodenfläche malen, auf der der Spieler sich bewegen kann. Im „Grid 
Types“ Fenster auf der rechten Seite sehen Sie eine Auswahl-Box namens „Floor“. 
1) Wählen Sie den Boden-Typen „Floor“. 
 Ebenso wie beim Wasser gibt es hier keine eigentliche Lösch-Funktion. Sie müssen den Boden-Typ „No Floor“ 
auswählen, um unerwünschte Boden-Kacheln loszuwerden. 
2) Klicken Sie mit der linken Maustaste in das Raster und ziehen Sie die Werkzeugspitze über Kacheln im Raster, um 
Boden-Kacheln zu malen. 
 Jede Kachel, über die sie die Maus bei gedrückter Maustaste ziehen, sollte sich in eine Boden-Kachel 
umwandeln. 



 
 
6.2.2 Die Wände malen 
 Das Malen von Wänden erfolgt ähnlich dem von Böden.  
1) Wählen Sie den gewünschten Wand-Typ aus der „Walls“ Auswahl-Box im „Grid Types“ Fenster. 
 Genau wie beim Boden müssen Sie auch bei den Wänden den Trick mit „No Wall“ anwenden. 
2) Klicken Sie mit der linken Maustaste auf die Kante einer Wand, um ein neues Wand-Segment zu setzen. Durch 
Bewegen der Maus, während Sie die Maustaste gedrückt halten, ziehen Sie eine Wand entlang der Strecke, die Sie 
gerade abgefahren sind. 

 
 
6.2.3 Features einsetzen 
 Ein weiterer Aspekt, der in ein Raster gemalt werden kann, sind Features. Dabei handelt es sich um spezielle 
Aspekte eines Dungeons wie beispielsweise Türen. 
1) Wählen Sie „Dng_Egypt01_Base_EntranceG_Int01“ aus dem Features-Auswahlfenster des „Grid Types“ Fensters. 

 
2) Klicken Sie auf eine der beiden Kacheln zwischen den Fackeln am Ende des Rasters. Nun hat unser Dungeon auch 
eine richtige Tür. 

 
 
6.2.4 
Noch eine Bemerkung zu multiplen Stockwerken. Obwohl es mit dem Editor möglich ist, Dungeons mit multiplen Etagen 
zu bauen, wird dies durch den vorhandenen Kachel-Satz nicht unterstützt. Wir empfehlen daher, es so zu machen wie wir 
–  multiple Dungeons mit Treppen zu verbinden. 



 
6.3 Abschließen einer Welt mit Raster 
 
6.3.1 Objekte in einem Raster platzieren 
 Das Platzieren von Objekten in einem Raster funktioniert genau wie im Terrain. 
1) Wählen Sie das Objekt-Platzierungs-Werkzeug aus. 
2) Wählen Sie das zu platzierende Objekt aus dem Verzeichnis-Fenster. 
3) Klicken Sie in das Raster, um das Objekt zu platzieren. 
 
6.3.2 Eine Welt mit Raster erstellen 
 Welten mit Raster-Regionen werden genau wie solche ohne Raster erstellt. 
1) Erstellen Sie alle Pathing Meshes und Karten. 
2) Speichern Sie alle Dateien. 
3) Setzen Sie die .wrl -und .lvl-Dateien in einer .map-Datei zusammen. Falls Sie eines Ihrer Raster in verschiedene 
Etagen unterteilt haben, vergessen Sie nicht, dass jede Stockwerk-.lvl-Datei einzeln in die .map-Datei integriert werden 
muss. 
4) Erstellen Sie die .map-Datei.



Tutorial 7: Ausgefallene Objekte  
 Also, wir wissen inzwischen, wie wir gute Jungs und böse Jungs platzieren. Wir wissen auch, wie wir sie bewegen 
und drehen können. Aber sind wir doch mal ehrlich, es gibt noch mehr im Spiel als böse Jungs. Dieses Tutorial wird sich 
nun intensiver mit platzierbaren Objekten und deren Verwaltung beschäftigen. 
 
7.0.1 Die Umgebung erkunden  
1) Starten Sie den Titan Quest Editor. 
2) Wählen Sie das Mod „Tutorial07“ aus. 
3) Finden und öffnen Sie „Tutorial-Fanciness_Jungle_Terrain.lvl“ im Editor Mode. 
 Sie sehen einen Wasserfall über einem Weiher. Außerdem befinden sich hier einige Hügel und Trampelpfade, die 
sich durch das Gelände ziehen und entlang derer es ein paar Kreise gibt. Diese werden Wanderpunkte  genannt. 
Zwischen ihnen wandern NPCs umher, wenn sie sonst nichts zu tun haben. Einige NPCs sind auch schon zu sehen, die 
dann im Spiel zwischen den Wanderpunkten auf und ab laufen sollen. 
 
7.1 Die Objekt-Palette  
 Mit der Zeit werden Sie feststellen, dass es ein oder zwei Objekte gibt, die Sie oft benutzen und die im 
Verzeichnis-Fenster so weit auseinander liegen, dass es sehr mühsam ist, sie bei jeder Benutzung erneut suchen zu 
müssen. Zum Glück gibt es die Objekt-Palette . In ihr lassen sich häufig benutzte Objekte zum schnelleren Zugriff 
ablegen.  
 
7.1.1 Hinzufügen eines Objekts zur Objekt-Palette  
In diesem Beispiel werden wir der Objekt-Palette einen schwachen Satyr hinzufügen. 
1) Wählen Sie das Objekt-Platzierungs-Werkzeug aus. 
2) Klicken Sie im Verzeichnis-Fenster auf „records -> creature -> monster -> satyr -> am_peltast_02“. 
3) Klicken Sie auf den „Add to Palette“ Knopf unterhalb des Verzeichnis-Fensters. 

 
 „am_peltast_02” wird daraufhin in der Objekt-Palette erscheinen. 

 
 
7.1.2 Ein Objekt aus der Objekt-Palette in das “Lev el Edit” Fenster setzen  
 Die Objekt-Palette funktioniert genau wie das Verzeichnis-Fenster. 
1) Wählen Sie das gewünschte Objekt aus der Objekt-Palette aus. 
2) Klicken Sie auf das Gelände im „Level Edit“ Fenster, um das Objekt zu platzieren. 
 
7.2 Gruppen 

 
 Gruppen stellen eine Möglichkeit dar, ähnliche Objekte zu gruppieren. Oftmals muss ein Objekt in eine 
bestimmte Gruppe integriert sein, um richtig zu funktionieren. Wir werden deshalb eine Gruppe NPCs erstellen, die in der 
Karte herumlaufen. Es sind ja bereits einige NPCs in der Karte vorhanden, allerdings stehen sie solange nur herum, bis 
sie in eine Gruppe eingeschlossen werden, die sie zum umherlaufen bringt. 
  
7.2.1 Gruppen erstellen 
Um die NPCs zum Spazieren zu bringen, benötigen wir zwei Gruppen. 
1)  Wählen Sie das Gruppen-Werkzeug aus. 
 Im „Group List” Fenster auf der rechten Seite sollte bereits eine Gruppe namens „Wander Points” vorliegen. 
2) Klicken Sie auf den Knopf „New” unterhalb des „Group List“ Fensters. 



 
3) Ändern Sie den Namen im Bereich „Group Properties” des „Group List“ Fensters in „The Wanderers”. 
4) Ändern Sie den Typ im Bereich „Type“ des „Group List“ Fensters zu „Npc Wanderers“.  

 
5) Erstellen Sie als nächstes eine weitere Gruppe für die Wanderpunkte. Nennen Sie sie „Wander Here” und legen Sie als 
Typ „Wander Points“ fest. 
 Die erste Gruppe wird die NPCs beinhalten, während die zweite all die Gebiete einschließt, in der sich die NPCs 
bewegen sollen.   
 
 
7.2.2 Gruppen verknüpfen  
1) Falls die „Wander Here” Gruppe noch ausgewählt ist, klicken Sie nacheinander mit der linken Maustaste auf die beiden 
Drahtmodell-Sphären (diese heißen „bounding volumes”). Rote Boxen erscheinen nun um die einzelnen Sphären und 
zeigen so an, dass sie zur Gruppe gehören.  
2) Wählen Sie nun „The Wanderers” aus und klicken Sie nacheinander mit der linken Maustaste auf die drei NPCs. Rote 
Boxen zeigen erneut an, dass die NPCs verknüpft sind. 
3) Klicken Sie auf das „Link Mode” Kästchen im „Group List” Fenster. Es erscheint ein schwarzer Punkt zwischen den 
beiden „bounding volumes“. Wenn Sie mit der linken Maustaste darauf klicken, taucht ein großer blauer Pfeil auf, der 
anzeigt, dass die NPCs den Wanderpunkten zugeteilt sind.   

 
Die gruppierten NPCs werden nun zwischen den beiden Wanderpunkten hin- und herlaufen. Sie sollten generell 
mindestens zwei Wanderpunkte haben und Ihre spazierenden NPCs dazwischen positionieren. 
 
7.3 Geräusche  
 
 Um in Titan Quest ein Geräusch zu erzeugen, muss man ein Sound-Objekt einfügen. Je näher ein Spieler dem 
Sound-Objekt kommt, desto lauter wird das Geräusch. 
 
7.3.1 Erstellen einer Geräusch-Quelle  
1) Wählen Sie das Objekt-Platzierungs-Werkzeug aus. 
2) Wählen Sie aus dem Verzeichnis-Fenster das Objekt „records -> sounds -> soundobjects -> waterfall01“ aus. 
3) Platzieren Sie das Objekt am Grund des Wasserfalls. 
 Es erscheint daraufhin eine grüne Säule. Je näher ein Spieler diesem Objekt kommt, desto lauter wird das 
Geräusch. 



 
 
 
7.4 Respawn-Punkte  
 Ein Respawn-Punkt ist ein Ort, an dem ein Spieler wiedergeboren wird, wenn er stirbt. Allerdings können 
Respawn-Punkte erst benutzt werden, nachdem der Spieler in das Objekt hineingelaufen ist, welches den Respawn-
Punkt repräsentiert, (beispielsweise ein Brunnen der Wiedergeburt). Wenn ein Spieler stirbt, wird er an dem Respawn-
Punkt wiedergeboren, den er zuletzt aktiviert hat. Einen funktionierenden Respawn-Punkt zu erstellen, ist leider etwas 
komplizierter, als einfach ein Objekt aus dem Verzeichnis-Fenster auszuwählen und es in die Welt zu setzen. 
 
7.4.1 Erstellen von Respawn-Punkten  
1) Wählen Sie aus dem Verzeichnis-Fenster das Objekt „records -> item -> shrines -> respawntemplegreece01“. 
2) Setzen Sie ein paar Respawn-Tempel in das Gelände. 
3) Wählen Sie das Gruppen-Werkzeug. 
4) Erstellen Sie eine neue Gruppe. 
5) Geben Sie der Gruppe den Namen „Respawn Shrines”. 
6) Stellen Sie den Typ der Gruppe auf „RespawnShrine”. 
7) Fügen Sie die Respawn-Objekte der Gruppe hinzu. 
 Jetzt sind die Respawn-Objekte im Spiel einsatzbereit. Im Allgemeinen empfiehlt es sich, erst das Level zu 
erstellen und die Respawn-Schreine am Ende hinzuzufügen und zu verknüpfen. 

 
 
 
7.5 Schatztruhen  
7.5.1 Implementieren von Schatztruhen  
 Als Schatztruhen werden Objekte bezeichnet, die hilfreiche Gegenstände freigeben, wenn der Spieler mit Ihnen 
interagiert. Sobald er das tut, öffnet sich die Truhe, und mehrere Gegenstände kommen herausgeflogen. 
1) Wählen Sie „records -> item -> containers -> greece -> monsterchest_epic_01a”. 
2) Platzieren Sie das Objekt auf der Karte. 
3) Speichern Sie die Karte im Editor und erstellen Sie die .map-Datei. 
4) Interagieren Sie im Spiel mit der Schatztruhe und sehen Sie, wie Schätze herausfliegen.



Tutorial 8: Von Region zu Region reisen 
 
 Inzwischen wissen wir, wie man Terrains erstellt und Raster kreiert. Von einem Terrain zum nächsten zu 
gelangen ist einfach; man muss sie nur genau nebeneinander platzieren. Ein Terrain mit einem Raster oder zwei Raster 
untereinander zu verbinden, ist schon schwieriger. Dafür müssen wir Portale benutzen. Diese sind im Grunde genommen 
nichts anderes als Türen von der einen Region zur anderen. Eine andere Möglichkeit, einen Spieler-Charakter zu 
bewegen, ist die Teleportation an einen bestimmten Punkt mittels Teleport-Auslösern. 
 
8.0.1 Setup 
1) Öffnen Sie den Editor. 
2) Wählen Sie das Mod „Tutorial08” aus. 
3) Öffnen Sie die Region „Tutorial-Connecting_To_Dungeons_Terrain.lvl” im Editor Mode. 
 Sie werden feststellen, dass es dort eine Terrain-Region und eine Raster-Region gibt. In der Terrain-Region 
befindet sich ein Höhleneingang am Fuß einer Klippe. 
 

 
 
 
8.1 Portale 
 
8.1.1 Erschaffen eines Portals  
 Portale lassen sich in bestimmte Arten von Objekten integrieren. Eines dieser Objekte ist „records -> underground 
-> naturalcave -> greecedngentrance_a01_ext.dbr”, bei dem es sich um die Höhle handelt, die in der Terrain-Region in 
die Felswand eingelassen ist. Das ist eines der Portale, die wir verbinden wollen. Allerdings benötigen wir noch eins 
innerhalb des Rasters. 
1) Wählen Sie das Raster-Werkzeug aus. 
2) Wählen Sie nun die Raster-Region „Tutorial-Connecting_To_Dungeons_Dungeon.lvl“ aus. 
 Man kann ein Portal im Raster unter anderem erstellen, indem man ein Objekt im Raster platziert, das ein Portal 
beinhaltet, genau wie in einer Terrain-Region. Auf der anderen Seite können Portale jedoch auch in eine Vielzahl von 
Raster-Features eingebaut werden. 
3) Sie werden feststellen, dass ein großes Stück Wand fehlt. Sie müssen das Höhlen-Eingangs-Feature auf einem Punkt 
platzieren, an dem sich keine Wand befindet. 
4) Wählen Sie „GreeceNatCave_EntranceG_Int01” aus der Feature-Liste. 

 
5) Positionieren Sie es in der Lücke. Anfangs kann das Portal noch in die falsche Richtung zeigen. In diesem Fall rotieren 
Sie es mit Hilfe der Pfeil-Tasten solange, bis es passt, und platzieren Sie es erneut. Die Pfeil-Tasten rotieren das Feature 



jeweils um 90°, allerdings müssen Sie es erneut ein setzen, um die Drehung zu sehen. 

 
 
8.1.2  Verbinden zweier Portale  
1) Wählen Sie das Portal-Werkzeug aus. 

 
2) Klicken Sie auf den Ellipsen-Knopf rechts neben dem oberen Feld im „Link Portals“ Fenster. 

 
3) Wählen Sie das Portal am Höhleneingang der Terrain-Region. 
 Wählen Sie dabei nicht das Objekt an sich an, sondern das tatsächliche Loch im Objekt. 

 
 In dem oberen Feld im „Link Portals“ Fenster erscheint nun die Portal-Nummer. 
4) Klicken Sie auf den Ellipsen-Knopf rechts neben dem unteren Feld im „Link Portals“ Fenster. 

 
5) Klicken Sie auf das offene Ende des Eingangs-Features in der Höhle der Raster-Region. Drehen Sie die Kamera so, 
dass Sie von der Höhle aus auf das Eingangs-Feature schauen. 



 
 Es erscheint eine weitere Portal-Nummer in dem unteren Feld des „Link Portals“ Fensters. 
6) Klicken Sie auf den „Link“ Knopf im „Link Portals“ Fenster. 

 
 Über beiden Portalen erscheint nun der Name des Geländes, in dem sie sich befinden. 
 Die Portale sind jetzt verknüpft. 
7) Erstellen Sie alle Pathing Meshes und Karten, um sich gar nicht erst schlechte Gewohnheiten anzueignen. 
8) Speichern Sie alles. 
9) Öffnen Sie den Art Manager. 
10) Öffnen Sie „Tutorial-Connecting_To_Dungeon.map“ im Ordner „Tutorial08\assets” und wählen Sie in der Menüleiste 
„Build -> Build“. 
 Wenn Sie jetzt die Karte im Spiel verwenden, sind die Portale verbunden. Lassen Sie Ihren Charakter in eines der 
Portale laufen, und er wird im anderen, das damit verknüpft ist, erscheinen. 
 
 
8.2 Teleportieren  
 
 Eine weitere Möglichkeit, den Spieler durch die Karte zu bewegen, ist die Teleportation. Der Spieler kann über 
einen Auslöser im Quest Editor mit der Aktion „Teleport Player to N., N., N.“ teleportiert werden. (Keine Sorge, wir werden 
Ihnen im nächsten Tutorial alles zu Aktionen erzählen.) Wie gelangt man jetzt aber an die richtigen Koordinaten, zu denen 
man teleportieren will? 
 
8.2.1 Teleportations-Koordinaten erhalten  
1) Laden Sie eine Welt in den Editor. 
2) Öffnen Sie ein Level im Editor Mode. 

 
3) Zentrieren Sie die Welt auf den Punkt, für den Sie die Teleportations-Koordinaten finden möchten. 
4) Wählen Sie in der Menüleiste „Camera -> Locate Coords” aus. 
 Es öffnet sich daraufhin ein Fenster mit den X-, Y-, und Z-Koordinaten des Punktes in der Mitte des Fensters. 





Tutorial 9: Erstellen eines Auslösers 
 
 In dieser Sektion stellen wir Ihnen den Quest Editor vor – nicht zu verwechseln mit dem Titan Quest Editor, der 
benutzt wird, um Karten zu erstellen. Quests für das Spiel werden in Quest - („.qst“-) Dateien gespeichert. Jede Quest-
Datei besteht dabei aus einer Serie von Auslösern , die das Voranschreiten der Quest kontrollieren. Jeder Auslöser 
besitzt eine Reihe von Bedingungen  und Aktionen , die so funktionieren, dass die Aktionen des Auslösers erst 
ausgeführt werden, wenn alle Bedingungen des Auslösers erfüllt sind. Im Rahmen dieses Tutorials werden wir einen 
einfachen Auslöser anlegen, bei dem ein Spieler 10 Erfahrungspunkte erhält, sobald er ein bestimmtes Gebiet betritt. 
 
Setup 
1) Öffnen Sie den Art Manager 
2) Klicken Sie in der Menüleiste auf „Mod -> Select“ und wählen Sie „Tutorial09“ aus. 
3) Wählen Sie in der Menüleiste „Build -> Build“. 
 
Alle Datenbank-Einträge sind nun im Editor verfügbar. 
 
9.1 Auslöser  
 
9.1.1 Quest-Dateien  
 Der Auslöser, den wir erstellen wollen, wird in eine bereits bestehende Quest integriert. 
1) Öffnen Sie den Quest Editor. 
2) Klicken Sie in der Menüleiste auf „File -> Select Mod…”, wählen Sie „Tutorial09” aus und klicken Sie auf „OK“. 
3) Klicken Sie in der Menüleiste auf „File -> Open…“ und wählen Sie „Eigene Dateien\My Games\Titan 
Quest\custommaps\tutorial09\resources\Quests\Tutorial-Experience_Trigger.qst“. 
 Wenn Sie im linken „Files” Fenster auf „Experience Trigger” klicken, werden Sie feststellen, dass es im mittleren 
„Script Data“ Fenster einen Eintrag mit dem Namen „Only One Step” gibt. Auslöser werden in Schritte („Steps“) 
zusammengefasst, um es dem Designer leichter zu machen, dem Ablauf der Mission zu folgen. 

 
 
9.1.2 Erstellen eines Auslösers  
1) Wählen Sie den Schritt („Step”), dem Sie den Auslöser hinzufügen wollen. 
2) Klicken Sie auf den „New Trigger” Knopf in der Werkzeugleiste. 



 
 Es erscheint daraufhin ein neuer Auslöser („New Trigger”) unter dem Schritt „Only One Step“. 
3) Wählen Sie den Auslöser aus, den Sie gerade erstellt haben. 
4) Im unteren „Properties” Fenster sehen Sie nun eine Reihe von Eigenschaften. 
 Um eine Eigenschaft zu modifizieren, machen Sie mit der linken Maustaste einen Doppelklick auf die Zelle rechts 
von „Name“ und geben Sie den neuen Wert ein. 
5) Geben Sie in das Namensfeld des Auslösers, den Sie gerade erstellt haben, „The Trigger“ ein. 
 
 
 
 
 
9.2 Bedingungen  
 
 Jeder Auslöser besteht aus einer Reihe von Bedingungen und Aktionen, die so funktionieren, dass die Aktionen 
des Auslösers erst ausgeführt werden, wenn alle Bedingungen des Auslösers erfüllt sind. Fangen wir also damit an, die 
Bedingungen des Auslösers zu erstellen. In unserem Fall besteht die Bedingung zum Aktivieren des Auslösers darin, 
dass ein Spieler einen bestimmten Bereich betritt. 
 
9.2.1 Erstellen einer Bedingung  
1) Klicken Sie auf den Eintrag „Conditions” unter dem Auslöser, den Sie bearbeiten möchten. 

 
2) Klicken Sie auf den „New Condition” Knopf. 

 
 Daraufhin öffnet sich das „Add New Condition” Fenster. Innerhalb des Fensters sehen Sie eine Liste möglicher 
Bedingungs-Typen. 
3) Wählen Sie „Enter Bounding Volume”. 

 
4) Klicken Sie auf „OK”. 
 Die Bedingung ist nun also darauf eingestellt, den Auslöser zu aktivieren, wenn der Spieler das „Bounding 
Volume“ betritt. Allerdings müssen wir noch spezifizieren, welches Bounding Volume. 
5) Klicken Sie auf „Enter Bounding Volume“ und schauen Sie auf das „Properties“ Fenster. 
 Sie sollten eine Eigenschaft namens „BaseDatabaseRecord” vorfinden. Hier legen wir fest, welches Bounding 
Volume der Spieler betreten muss, um den Auslöser zu aktivieren. 
6) Klicken Sie in das Feld rechts neben „BaseDatabaseRecord“. 



 
 Sie werden feststellen, dass Sie den Pfad manuell eintippen können, wie bei jeder anderen Eigenschaft auch. 
Des Weiteren befindet sich allerdings rechts des Feldes ein Ellipsen-Knopf, auf den Sie klicken können. Wenn Sie auf 
diesen Knopf drücken, wird automatisch der Wert übernommen, der rechts im „Asset Chooser“ Fenster ausgewählt ist. 
Dies ist äußerst hilfreich, wenn Sie nicht jedes Mal lange, schwierige Pfade von Hand eintippen wollen. 
7) Wählen Sie im „Asset Chooser” Fenster „Database -> triggers -> tutorial-sphere_of_experience.dbr” aus. 
8) Falls es nicht ausgewählt ist, klicken Sie auf die Bedingung „Enter Bounding Volume“, die Sie gerade erstellt haben. 
9) Klicken Sie im „Properties” Fenster auf den Ellipsen-Knopf hinter dem Datenfeld der Eigenschaft 
„BaseDatabaseRecord“. 

 
 Der Pfad von „tutorial-sphere_of_experience” sollte automatisch angezeigt werden. 
 Das wäre geschafft. Die Bedingung ist nun so eingestellt, dass etwas passieren wird, sobald ein Spieler das 
Bounding Volume betritt. Aber was passiert dann eigentlich? Um das festzulegen, müssen wir eine Aktion festlegen. 
 
 
9.3 Aktionen 
 
9.3.1 Erstellen einer Aktion  
1) Wählen Sie den Eintrag „Actions” unter dem Auslöser, dem Sie die Aktion zuteilen wollen. 

 
2) Klicken Sie auf den „New Action” Knopf in der Werkzeugleiste. 

 
 Daraufhin öffnet sich das „Add New Action” Fenster. Innerhalb des Fensters sehen Sie eine Liste möglicher 
Aktions-Typen. 
3) Wählen Sie „Give Player N, N, N Experience“ aus. 



 
4) Drücken Sie „OK“. 
 Nun ist der Auslöser so eingestellt, dass er dem Spieler Erfahrungspunkte gibt, sobald dieser den Bereich betritt. 
Wir müssen nur noch einstellen, wie viel. 
5) Wählen Sie die neue Aktion aus, um ihre Eigenschaften angezeigt zu bekommen. 
Die drei Eigenschaften, die uns interessieren sind „ExperienceEpic“, „ExperienceLegendary“ und „ExperienceNormal“. Sie 
legen fest, wie viele Erfahrungspunkte der Spieler erhalten soll, abhängig vom Schwierigkeitslevel. 
6) Sie können eingeben, was Sie wollen, aber als Anhaltspunkt sei empfohlen, alle auf 100 zu setzen. 

 
 
 
9.4 Speichern und Erstellen einer Quest  
 
9.4.1 Speichern und Erstellen der Quest-Datei  
 An dieser Stelle haben wir die Quest erfolgreich eingestellt und müssen sie nur noch speichern und erstellen. 
1) Speichern Sie die Quest, indem Sie in der Menüleiste „File -> Save” auswählen. 
 Wenn die Quest-Datei erst einmal gespeichert ist, muss sie noch erstellt werden. 
2) Öffnen Sie den Art Manager. 
3) Wählen Sie das Mod „Tutorial09” aus. 
4) Wählen Sie in der Menüleiste „Build -> Build”.  Aber halt, wir sind noch nicht ganz fertig! 
 

 
 
5) Öffnen Sie den Editor, wählen Sie „Tutorial09” aus und öffnen Sie „Tutorial-Sphere_of_Experience.wrl“. 
6) Klicken Sie in der Menüleiste auf „Quests -> Select Files…”. Es öffnet sich das „Quests“ Fenster. Wenn Sie auf „Add“ 
klicken, öffnet sich das „Select Files“ Fenster. Erweitern Sie dort „Resources -> Quests“ und klicken Sie auf „tutorial-
experience_trigger.qst”. Sie gelangen wieder zum „Quests“ Fenster und müssen nun auf „OK“ klicken. 
7) Speichern Sie das Level, kehren Sie zum Art Manager zurück und erstellen Sie alles erneut. 
 
 Jetzt ist es soweit, dass wir der Quest einen Besuch im Spiel abstatten sollten! 



 
 
9.4.2 Testen des Auslösers  
1) Starten Sie Titan Quest. 
2) Wählen Sie im Hauptmenü „Eigenes Spiel spielen“. 
3) Wählen Sie „tutorial09 ~ tutorial-sphere_of_experience.map“. 
4) Klicken Sie nach dem Erstellen bzw. Auswählen Ihres Charakters auf „Start“, um Ihre Karte zu spielen. 
5) Steuern Sie den Charakter in den hübsch gefliesten Kreis. 
 Wenn alles korrekt durchgeführt wurde, erhalten Sie eine Nachricht, dass Sie Erfahrungspunkte erhalten haben.



Tutorial 10: Erstellen eines Mods ganz von vorne 
Bisher haben wir gelernt, bereits vorbereitete .wrl-, .lvl- und .map-Dateien zu bearbeiten, um eine spielbare Karte zu 
erstellen. Jetzt stellt sich aber die Frage, wo diese Dateien eigentlich herkommen. 
 
10.1 Erstellen eines Mods  
1) Öffnen Sie den Art Manager. 
2) Wählen Sie in der Menüleiste „Mod -> New…” aus. Es erscheint das „New Mod“ Fenster. Geben Sie im Feld „New Mod 
Name“ den gewünschten Namen für Ihr Mod ein. Der Name wird nun in allen Registerkarten als Basis-Ordner angezeigt. 
3) Nun ist es an der Zeit, ein paar Dinge zu erstellen. Klicken Sie auf die Registerkarte „Sources” unterhalb des 
Verzeichnis-Fensters und klicken Sie mit der rechten Maustaste anschließend auf Ihren Basis-Ordner. Wählen Sie im 
Popup-Menü „Create Directory…” und legen Sie nacheinander zwei Ordner namens „Maps“ und „Quests“ an. (Ggf. 
erscheinen beim Anlegen des Ordners „Maps“ gleichzeitig die Ordner „Quests“ und „Text“. Dann müssen Sie keine 
weiteren Ordner erstellen.) Für eine gute Ordnung empfehlen wir, alle Level-Dateien im Ordner „Maps“ und alle Quest-
Dateien im Ordner „Quests“ zu sichern. 

  
 
 
10.2 Erstellen einer .wrl- und einer .lvl-Datei 
Jetzt haben Sie einen Ort, an dem Sie Ihre Karten speichern können. Es ist an der Zeit, diese auch zu erstellen, also 
starten Sie den Editor. 
 
1) Wählen Sie das Mod, das Sie gerade erstellt haben, erweitern Sie den „source“ Ordner und klicken Sie auf das 
Verzeichnis „Maps“. 
2) Wählen Sie einen Namen für Ihre Karten-Dateien, der auf „.lvl“ endet (stellen Sie sicher, dass der „Create a new World” 
Knopf ausgewählt ist) und klicken Sie „OK“. 

 
3) Sie sollten nun eine leere Karte vor sich haben. Sie benötigen also Level. 
4) Wählen Sie in der Menüleiste „Region -> Add New Terrain…”. Erweitern Sie im nun erscheinenden „New Terrain“ 
Fenster „source“ und klicken Sie auf das Verzeichnis „Maps“. Geben Sie unter „File name“ den gewünschten Namen für 
das Level ein und wählen Sie unten im Fenster die gewünschte Größe des Levels. (Nebenbemerkung: 256x256 ist groß!) 
Klicken Sie auf „OK“ 
 

Jetzt könnte es losgehen mit Terraforming, dem Platzieren von Strukturen, Monstern und Menschen. Allerdings 
möchten wir erst einmal weiter kommen, also erstellen Sie Pathing Meshes und Karten, speichern Sie alles und kehren 
Sie zum Art Manager zurück. 



 
Dort angekommen, sollten Sie Ihre Dateien bereits im „Maps“ Ordner der „Sources“ Registerkarte vorfinden. Ihre nächste 
Aufgabe besteht darin, Güter zu erstellen. 

 
10.3 Erstellen von Gütern 
1) Finden Sie die .wrl-Datei in der „Sources” Registerkarte im Ordner „Maps” und klicken Sie mit der rechten Maustaste 
darauf. Wählen Sie im Popup-Menü „Auto-Create Asset” aus. Im daraufhin erscheinenden „Map Properties“ Fenster sollte 
Ihre Datei bereits angezeigt werden. Klicken Sie auf „OK“. 
2) In der „Assets” Registerkarte wird das Verzeichnis „Maps” mit der .map-Datei angelegt. 

 
3) Wählen Sie die „Assets” Registerkarte, erweitern Sie ihren Basis-Ordner und „Maps“ und machen Sie anschließend mit 
der linken Maustaste einen Doppelklick auf Ihre .wrl-Datei. 
4) Klicken Sie auf „Add” und finden Sie die Level, die zu Ihrer Karte gehören. Wenn alle hinzugefügt sind, klicken Sie auf 
„OK“. 

  
5) Erstellen Sie Ihr Mod! 
 
Quests einzufügen erfordert etwas mehr Arbeit. In Tutorial 12 finden Sie weitere Informationen zum Eingliedern von 
Quests in Ihr Mod. 
 
 
 



Tutorial 11: Benutzen eines Datenbank-Eintrags 
 Jedes Objekt, das in Titan Quest vorkommt, hat einen so genannten Datenbank-Eintrag. Dieser besteht aus einer 
Reihe von Werten, die festlegen, wie ein Objekt aussieht und sich verhält, darunter „3D Mesh“, „Drawscale“ und Anzahl 
von Trefferunkten. In diesem Beispiel werden wir eine riesige Schildkröte bauen. Diese „Äußerst Gigantische Schildkröte“ 
wird mit der durchschnittlichen gigantischen Schildkröte identisch sein, außer, dass sie in jeder Richtung fünfmal so groß 
ist. 
 
In den Level und Quest Editoren sind alle vorgegebenen Datenbank-Einträge zu sehen, die man benutzen kann, um 
Objekte, Monster sowie NPCs zu platzieren und sie mit Quests zu verbinden. Voraussichtlich werden Sie für viele Quests 
kleinere Modifikationen vornehmen wollen. Dazu müssen Sie Datenbank-Einträge in Ihr Mod importieren. 
 
11.1.1 Importieren von Datenbank-Einträgen 
Importieren Sie die original Titan Quest Datenbank-Einträge, um Sie zu modifizieren oder mit ihrer Hilfe neue zu erstellen. 
Datenbank-Einträge, die Sie in Ihr Mod importieren und modifizieren, ersetzen dabei die Originale – selbstverständlich nur 
für Ihr Mod.   
 
1) Wählen Sie im Art Manager die „Database“ Registerkarte aus und wählen Sie in der Menüleiste „Mod -> Import 
Record…“.  
2) Wählen Sie aus der Liste der Einträge einen zum Importieren aus. Wählen Sie in unserem Fall „records -> creature -> 
monster -> giantturtle -> am_snapper_08.dbr“ aus und klicken Sie anschließend auf „OK“. 

 
 
 Unsere „Äußerst Gigantische Schildkröte” nimmt als Kopie einer ganz normalen Riesenschildkröte ihren Anfang. 
3) Importierte Einträge werden primär in dem Ordner abgelegt, in dem sie ursprünglich gefunden wurden. Das schafft 
viele überflüssige Unterordner. Erweitern Sie im Verzeichnis-Fenster die Ordner „database -> records -> creature -> 
monster” und klicken Sie auf „giantturtle“. Bei größeren Mods empfiehlt es sich, alle Einträge besser zu sortieren, z.B. in 
Ordnern wie „Monster“, „NPCs“, „Quests“ etc. 
 Kopieren Sie nun die .dbr-Datei im Ordner-Fenster so, wie sie auch in Windows eine gewöhnliche Datei kopieren. 
4) Klicken Sie mit der rechten Maustaste auf „am_snapper_08.dbr“ im Ordner-Fenster. 
5) Klicken Sie im Popup-Menü auf „Copy”. 
 Wenn die Datei einmal in die Ablage kopiert ist, kann sie überall eingefügt werden. 



6) Wählen Sie im Verzeichnis-Fenster den Ordner „database -> records“. 
7) Klicken Sie mit der rechten Maustaste irgendwo in das Ordner-Fenster rechts. Wählen Sie „Paste” im Popup-Menü 
aus. 
 Es erscheint eine Kopie der Datei „am_snapper_08.dbr“. 
 Obwohl das theoretisch gesehen funktioniert, sollten wir ihr vielleicht doch einen besseren Namen geben. 
8) Klicken Sie mit der rechten Maustaste auf die Datei „(Copy of) am_snapper_08.dbr“. 
9) Wählen Sie „Rename“ aus dem Popup-Menü. 
10) Geben Sie als neuen Namen „Very_Giant_Turtle.dbr“ ein. 

 
 
11.1.2 Bearbeiten eines Datenbank-Eintrags  
 Großartig, jetzt haben wir einen neuen Objekt-Typ. Aber wo ist eigentlich der Unterschied zu einer gewöhnlichen, 
blöden Schildkröte? Naja, zunächst einmal wird sie in jeder Richtung ungefähr fünfmal so groß sein. Um das zu schaffen, 
müssen wir ein paar Eigenschaften unserer „Äußerst Gigantischen Schildkröte“ verändern. 
1) Durch einen Doppelklick mit der linken Maustaste auf die zu bearbeitende Datei im rechten Ordner-Fenster kommen 
Sie in das „Editing Record” Fenster. 
 Das „Editing Record“ Fenster ist in zwei weitere Fenster unterteilt. Links befindet sich das Hierarchie-Fenster , in 
dem die Hierarchie der Eigenschafts-Typen für das gewählte Objekt angezeigt wird. Rechts hingegen liegt das 
Eigenschafts-Fenster , in dem die Eigenschaften und ihre jeweiligen Werte angezeigt werden, sobald eine Kategorie von 
Eigenschaften ausgewählt wurde. Jede Zeile repräsentiert eine gesonderte Eigenschaft, und in den Spalten werden 
zusätzliche Informationen zu den jeweiligen Eigenschaften angezeigt. Die Spalte, die uns am meisten interessiert, ist jene 
mit dem Namen der Datei, die wir gerade bearbeiten; in unserem Fall also „Very_Giant_Turtle.dbr“. Zellen in dieser 
letzten Spalte, auch Werte-Zellen  genannt, beinhalten die eigentlichen Werte für die jeweilige Eigenschaft.  
2) Um einen Wert zu ändern, muss man mit der linken Maustaste einen Doppelklick in der jeweiligen Zelle durchführen 
und den neuen Wert anschließend eingeben. 
 Viele Werte-Zellen zeigen während der Bearbeitung eine Ellipse an. Wenn Sie im Art Manager gerade einen 
Datenbank-Eintrag ausgewählt haben und auf die Ellipse klicken, wird die Eigenschaft im „Editing Record“ Fenster den 
Wert der ausgewählten Datei annehmen. Dadurch wird vermieden, dass man unter Umständen ellenlange Pfade von 
Hand tippen muss. 
 Wir haben vor, zwei Eigenschaften in der Gruppe „All Groups -> Actor Variables“ zu verändern, nämlich „scale “, 
wodurch die Grüße der Schildkröte festgelegt wird und „actor Radius “, wodurch bestimmt wird, wie nah ein anderes 
Objekt an das Zentrum der Schildkröte herankommen kann. 

 
3) Wählen Sie die „All Groups -> Actor Variables” Kategorie im Hierarchie-Fenster aus. 
4) Wählen Sie die Werte-Zelle der Eigenschaft „scale“ durch Doppelklick mit der linken Maustaste aus. 
5) Geben Sie als Wert „5“ ein. 
6) Wählen Sie nun die Werte-Zelle der Eigenschaft „actorRadius“ aus. 



7) Geben Sie als Wert „5“ ein. 

 
8) Speichern Sie die Einstellungen unter „File -> Save“ in der Menüleiste und schließen Sie das „Editing Record“ Fenster. 
 
11.1.3 Erstellen eines Datenbank-Eintrags  
 Da wir nun die Werte des Datenbank-Eintrags verändert haben, müssen wir die neuen Werte noch in die 
Datenbank einbauen, die vom Spiel gelesen wird. 
1) Klicken Sie mit der rechten Maustaste auf den Basisordner „<Mod-Name>\database“. 
2) Klicken Sie im Popup-Menü auf „Build”. 

 
 Der neue Datenbank-Eintrag ist nun in die Datenbank eingebaut, und Sie können ihn im Editor wie jedes andere 
Objekt benutzen. Jetzt wissen wir also, wie man in Titan Quest ein neues Objekt kreiert. Haben Sie Spaß damit, die 
Eigenschaften zu verändern und zu sehen, welche neuen Kombinationen an Eigenschaften Sie finden.



Tutorial 12: Quests 
 
 Erinnern Sie sich noch an den Dorfbewohner, dessen Dorf wir in Tutorial04 retten mussten? Jetzt werden wir uns 
ein wenig näher damit beschäftigen, wie das eigentlich funktioniert hat. Nämlich mit einer Quest-Datei. Diese besteht, Sie 
werden sich erinnern, aus einer Reihe von Auslösern, die den Handlungsablauf kontrollieren. Wir werden im Verlauf eine 
Serie von Ereignissen zusammenstellen. Diese sorgen dafür, dass der Dorfbewohner dem Spieler den Auftrag erteilt, er 
das Monster tötet und der Dorfbewohner dem Spieler nach getaner Arbeit seine Belohnung gibt. Zu jeder Quest gehören 
vier Haupt-Bestandteile: Schritte, Auslöser, Bedingungen und Aktionen. Schritte stellen eine Möglichkeit dar, Auslöser zu 
gruppieren und den Handlungsablauf so verständlicher darzustellen. Auslöser sind die wahren Schmankerl einer Quest. 
Ein Auslöser besteht aus Bedingungen und Aktionen, wobei letztere erst ausgeführt werden, wenn alle Bedingungen 
erfüllt sind.  
 
12.0.1 Setup  
Anmerkung: Eine fertige Version der Quest, die wir im Folgenden erstellen wollen, liegt bereits vor, und zwar unter dem 
Namen „Sample_Tutorial-Save_The_Village.qst“. Das Tutorial wird Sie durch die einzelnen Schritte zum Erstellen dieser 
Datei geleiten. Unsere selbst angefertigte Version wird am Ende „Tutorial-Save_The_Village.qst“ heißen.  
 
Obwohl der Großteil dieses Tutorials im Quest Editor stattfinden wird, müssen wir zuerst den Art Manager öffnen. 
1) Öffnen Sie den Art Manager. 
2) Wählen Sie das Mod „Tutorial12” aus. 
3) Wählen Sie in der Menüleiste „Build -> Build” aus. Dadurch werden alle Datenbank-Güter kompiliert. Die Quest-Güter 
betreffende Fehlermeldungen können Sie vorerst ignorieren.  
 
Jetzt auf zum Quest Editor.   
4) Öffnen Sie den Quest Editor. 
5) Klicken Sie in der Menüleiste auf „File -> Select Mod” und wählen Sie „Tutorial12” aus. 
Sie sollten das jeweilige Mod immer auswählen, wenn Sie Quest-Dateien anlegen oder bearbeiten.  
 
 
12.1 Marken  
 Marken ermöglichen es, stattgefundene Ereignisse aufzuzeichnen. Bei jedem wichtigen Quest-Ereignis kann man 
dem Spieler eine solche Marke zuteilen, die dann anzeigt, dass das Ereignis stattgefunden hat. Später in der Quest kann 
ein Auslöser dann prüfen, welche Marken der Spieler bereits besitzt und anhand dessen festlegen, welche Aktionen 
durchzuführen sind – je nachdem, was der Charakter bisher erledigt hat. 
 
Bevor es losgeht müssen Sie erst noch eine Marken-Datei erstellen, indem Sie in Ihrem Mod-Ordner (welcher sich in 
„Eigene Dateien\My Games\ Titan Quest\CustomMaps\<Mod-Name>\resources\Quests\“ befinden sollte) eine leere Datei 
namens „tokens.bin“ anlegen. Diese Datei wird dann dazu benutzt, Marken zu speichern. Sie muss nicht im Art Manager 
erstellt werden und benötigt auch kein Gut, um zu funktionieren. Am einfachsten ist es, unter Windows ein Text-Dokument 
in dem o.g. Ordner anzulegen (beispielsweise im Windows-Explorer) und es in „tokens.bin“ umzubenennen. Wenn 
Windows Sie anschließend warnt, dass Sie den Datei-Typ ändern, klicken Sie einfach auf „OK“. 
 
12.1.1 Erstellen einer Marke  
 Im nun folgenden Beispiel werden wir eine Marke erstellen, die anzeigt, dass der Spieler den Satyr getötet hat. 
Diese Marke kann dann später überprüft werden, um sicherzustellen, dass die Quest nicht weiterläuft, bevor alle 
benötigten Ereignisse eingetreten sind. 
1) Klicken Sie auf den „Token Editor“ Knopf in der Werkzeugleiste. Wählen Sie die Datei „tokens.bin” aus Ihrem Mod-
Ordner. 

 
 
2) Klicken Sie auf „Create Token”. 



 
 
 Das „Add New Token” Fenster öffnet sich. 
3) Sie können nun im Textfeld „New Token” einen Namen für Ihre Marke eintippen. Geben Sie in diesem Fall 
„Killed_Satyr“ ein. 

 
4) Klicken Sie auf „OK”. 
 Ihre Marke wurde nun der Marken-Datei hinzugefügt. 
 
 
 
 
12.2 Erstellen der eigentlichen Quest-Datei  
 
12.2.1 Erstellen einer Quest 
 Beginnen Sie, indem Sie ein neues Quest-Dokument erstellen. 
1) Klicken Sie in der Menüleiste auf „File -> New Quest Document” oder klicken Sie direkt auf den „New Quest Document“ 
Knopf. 

 
 Stellen Sie die Eigenschaften der Quest-Datei ein. 
2) Wählen Sie die neue Quest-Datei im „Files“ Fenster aus. 
 Um den Wert einer Eigenschaft zu ändern, müssen Sie im „Properties” Fenster auf das Feld rechts neben der 
jeweiligen Eigenschaft klicken und anschließend den gewünschten Wert eingeben. 
3) Geben Sie bei „QuestName” „Defeat the Satyr” ein. 
 Ein Spieler erhält Belohnungen erst dann, wenn die Quest abgeschlossen ist. Indem man Belohnungs-Werte 
einsetzt, weiß ein Spieler vorher schon, welche Art von Belohnung er nach Beenden der Quest erwarten kann. 
4) Setzen Sie „RewardGoldEpic” auf 200. 
5) Setzen Sie „RewardGoldLegendary“ auf 300. 
6) Setzen Sie „RewardGoldNormal“ auf 100. 
Anmerkung: Diese Werte garantieren nicht, was der Spieler am Ende tatsächlich als Belohnung erhält, sie legen nur fest, 
was dem Spieler angezeigt  wird. Sie müssen „give X” Aktionen benutzen, um dem Spieler Belohnungen zu geben. 



 
 
12.2.2 Erstellen von Schritten  
 Schritte stellen eine Möglichkeit dar, Quest-Auslöser durch die verschiedenen Ereignisse zu gruppieren, die im 
Verlauf einer Quest stattfinden. 
 Erstellen Sie den ersten Schritt. 
1) Klicken Sie auf den „New Quest Step“ Knopf. 
 
2) Wählen Sie den gerade erstellten Schritt aus. 
3) Geben Sie im „Properties” Fenster für die Eigenschaft „Name” den Wert „Setup” ein. 
 Erstellen Sie anschließend die weiteren drei Schritte der Quest. 
4) Klicken Sie auf den „New Quest Step“ Knopf. 
5) Ändern Sie den Wert der Eigenschaft „Name” des soeben erstellten Schritts in „Talk to the Villager”. 
6) Erstellen Sie einen weiteren Schritt. 
7) Ändern Sie den Wert der Eigenschaft „Name” dieses Schritts in „Kill the Satyr”. 
8) Erstellen Sie einen letzten Schritt. 
9) Ändern Sie den Wert der Eigenschaft „Name” des letzten Schritts in „Claim the Reward”. 

 
 
12.2.3 Erstellen eines Setup-Auslösers  
Ein Setup-Auslöser ermöglicht, Einstellungen zu ändern, falls ein Objekt in der Quest einen gewünschten Wert nicht von 
Hause aus besitzt. In unserem Fall möchten wir, dass der „Tutorial-Quest_Villager“ ein Ausrufezeichen über seinem Kopf 
hat, welches dem Spieler signalisiert, dass der Dorfbewohner eine Primär-Aufgabe darstellt. Der Auslöser wird eine 
Bedingung haben, die in Laden des Levels besteht. Die Aktion bei Erfüllen der Bedingungen besteht darin, den 
Dorfbewohner als Primär-Aufgabe zu markieren, indem ein goldenes Ausrufezeichen über seinem Kopf erscheint. 
 Erstellen Sie als erstes den Auslöser. 
1) Wählen Sie den Schritt „Setup” aus. 
2) Klicken Sie auf den „New Trigger“ Knopf in der Werkzeugleiste. 
3) Benennen Sie den gerade erstellten Auslöser in „Set Up the Villager” um. 
 Erstellen Sie als nächstes die Bedingung. 
4) Klicken Sie auf „Conditions” unterhalb des gerade eingerichteten Auslösers. 
5) Klicken Sie auf den „New Condition” Knopf in der Werkzeugleiste. 
 Es erscheint das „Add New Condition” Fenster. In diesem Fenster werden alle Arten von Bedingungen aufgelistet, 
die Aktionen in Gang setzen können. 
6) Wählen Sie die Bedingung „On Game Level Load” aus. 
 Als nächstes legen wir die Aktion fest. Der Dorfbewohner wird zur Primär-Aufgabe erklärt. 
7) Wählen Sie „Actions“ unterhalb der „Conditions“ aus und klicken Sie auf den „New Action” Knopf in der Werkzeugleiste. 
 Es erscheint das „Add New Action” Fenster. 
8) Wählen Sie „Illuminate X as Primary” aus. 
 Diese Aktion ist so programmiert, dass sie etwas als „primär” hervorhebt. Jetzt müssen wir noch festlegen, was 
genau zur Primär-Aufgabe ernannt werden soll. 
9) Wählen Sie die gerade hinzugefügte Aktion aus. 
10) Wählen Sie im „Properties“ Fenster das Feld rechts neben der Eigenschaft „NPC“ aus. 



 Sie können den Wert entweder manuell eintippen oder ein Objekt im Verzeichnis-Fenster ganz rechts auswählen 
und anschließend auf den Ellipsen-Knopf klicken. Dies ist der Knopf rechts neben dem Werte-Feld im „Properties“ 
Fenster. Er kopiert automatisch den Wert des im Verzeichnis-Fenster ausgewählten Objekts in das Werte-Feld. 
11) Erweitern Sie im rechten „Asset Chooser“ Fenster „Database -> npcs“ und klicken Sie auf „tutorial-quest_villager.dbr“. 
12) Klicken Sie anschließend auf den Ellipsen-Knopf rechts neben dem Werte-Feld für die Eigenschaft „Npc” im 
„Properties“ Fenster der als letztes erstellten Aktion. 
 Damit ist unser erster Auslöser fertiggestellt. Wenn Sie das Level nun laden, wird der Dorfbewohner als Primär-
Aufgabe markiert. 
 
12.2.4 Erstellen eines Interaktions-Auslösers  
 Wie wird einem Spieler eigentlich eine Quest zugeteilt? In unserem Fall bekommt der Spieler die Quest zugeteilt, 
indem er mit dem Dorfbewohner spricht. Wenn er dies tut, soll die Quest automatisch in seiner Aufgabenliste aktualisiert 
werden. Es gibt in der Aufgabenliste zwei Registerkarten. Eine ist die Zusammenfassung , in der die Quest-Aufgaben 
aufgelistet erklärt werden. Die zweite Registerkarte nennt sich Dialog  und kann benutzt werden, um vorangegangene 
Dialoge noch einmal wiederzugeben, in denen der Spieler über die Quest informiert wurde. 

 
 Erstellen Sie als erstes den Auslöser. 
1) Wählen Sie den zweiten Schritt „Talk to the Villager” aus. 
2) Klicken Sie auf den „New Trigger“ Knopf in der Werkzeugleiste. 
3) Benennen Sie den Auslöser in „Villager Gives Player Quest” um. 
 Nun zur neuen Bedingung. 
4) Erstellen Sie eine Bedingung für den Auslöser „Villager Gives Quest to Player”. 
5) Wählen Sie den Bedingungs-Typ „On Interact with X”. 
 Diese Bedingung ist so programmiert, dass eine Aktion abläuft, wenn der Spieler mit etwas interagiert. Demnach 
müssen wir als nächstes einstellen, womit der Spieler interagieren soll. 
6) Wählen Sie die gerade erstellte Bedingung. 
7) Geben Sie als Wert für die Eigenschaft „NPC“ im „Properties“ Fenster denselben „tutorial-quest_villager.dbr“ von eben 
ein.  
 Wenn der Spieler nun mit dem Dorfbewohner spricht, wird etwas passieren. 
 Zeit für die Aktionen, die daran beteiligt sind, die Aufgabenliste des Charakters im Spiel zu aktualisieren. 
8) Erstellen Sie eine Aktion für den Auslöser „Villager Gives Player Quest”. 



9) Wählen Sie als Aktions-Typ „Update This Quest's Map Marker“. 
 Damit werden die Quest-Aufgaben in der Aufgabenliste aktualisiert. Allerdings müssen wir noch festlegen, was 
die Aufgabe sein soll, wo sie sich befindet und ob sie als erledigt oder nicht erledigt gekennzeichnet werden soll. 
 Der im Spiel angezeigte Name einer Aufgabe wird „BulletPointTag” genannt. 
10) Geben Sie für die Eigenschaft „BulletPointTag“ der gerade erstellten Aktion den Wert „Kill The Monster” ein. 
Der Text für die Quest-Aufgabe ist in einer Datei namens „ModStrings.txt“ gespeichert, die sich im Text-Quell-Ordner 
befindet. Sie können Einträge hinzufügen, indem Sie pro Zeile einen Eintrag („Tag“) hinzufügen. Jede Zeile sollte dabei 
folgendes Format haben: <tag>=<text> . 
11) Geben für die Eigenschaft „DescriptionTag” den Wert „There is a monster attacking the village. Go kill it.“ ein. 
  

Im Aufgaben-Fenster des Spiels ist auch ein kleines Kästchen vorhanden, das den aktuellen Stand der Quest 
wiedergibt.  

Wir wollen, dass die Aufgabe zu diesem Zeitpunkt als noch nicht erledigt angezeigt wird. 
12) Setzen Sie den Wert für die Eigenschaft „DoCompleteBulletPoint“ auf „False“ – andernfalls würden Sie die Quest 
abschließen, anstatt sie zu beginnen. 

 Als letztes wollen wir noch sicherstellen, dass auch die Dialog-Registerkarte in der Aufgabenliste aktualisiert wird. 
13) Erstellen Sie eine neue Aktion vom Typ „Update X’s Dialog to X” für den Auslöser „Villager Gives Player Quest“. 
Diese Aktion besitzt eine besondere Eigenschaft: In Auslösern wie diesem („On Interact with X“ -> „Update X’s Dialog to 
X“), aktualisiert sich der Dialog während man auf den NPC klickt, also durch das Anklicken. Sprich, unser NPC hatte 
bisher keinen Dialog, bis wir ihm durch Anklicken etwas zu sagen gegeben haben. In anderen Situationen (mit anderen 
Bedingungen) ändert sich der NPC-Dialog jedoch lautlos, also ohne Anklicken. Das bedeutet, man hört den neuen Dialog, 
wenn man das nächste Mal auf den NPC klickt. 
14) Geben Sie als Wert für die Eigenschaft „NPC“ im „Properties“ Fenster wiederum den „tutorial-quest_villager.dbr“ ein. 
Geben Sie für die Eigenschaft „DialogPak“ der gerade erstellten Aktion den Wert „Database\dialog\tutorial-
villager_dialog_a.dbr“ ein. 
 
12.2.5 Erstellen eines Kreaturen-Tod-Auslösers  
 Wir wollen jetzt einen Auslöser erstellen, der das eigentliche Töten des Monsters behandelt. Wenn der Spieler 
das Monster tötet, soll er einen Marker erhalten, der den Tod anzeigt. Der Auslöser aktualisiert außerdem die 
Aufgabenliste und macht als letztes den Dorfbewohner wieder zur Primär-Aufgabe. 
1) Erstellen Sie einen Auslöser im Schritt „Kill The Satyr”. 
2) Nennen Sie den Auslöser „Get Credit for Killing the Monster”. 
3) Erstellen Sie eine Bedingung im Auslöser „Get Credit for Killing the Monster”. 
4) Wählen Sie als Typ der Bedingung „Kill Creature X”. 
 Legen Sie fest, welches Monster getötet werden muss, um den Auslöser zu betätigen. 
5) Geben Sie für die Eigenschaft „CreatureDatabaseRecord” der gerade erstellten Bedingung den Wert 
„Database\monsters\tutorial-quest_satyr.dbr“ ein.  
 Später müssen wir überprüfen, ob der Spieler das Monster schon getötet hat. Dementsprechend müssen wir dem 
Spieler einen Marker geben, der das aussagt. 
6) Erstellen Sie eine Aktion im Auslöser „Get Credit for Killing the Monster”. 
7) Wählen Sie als Aktions-Typ „Give Token X”. 
8) Wählen Sie die gerade erstellte Aktion „Give Token X“ aus. 
9) Klicken Sie auf den Ellipsen-Knopf rechts neben dem Werte-Feld für die Eigenschaft „Token“. 
10) Wählen Sie die Datei „tokens.bin” aus. 
11) Wählen Sie „Killed_Satyr" aus dem „Quest Tokens“ Fenster aus. 
 Wir legen als nächstes den Dorfbewohner wieder als Primär-Aufgabe fest. So weiß der Spieler, dass er zum 
Beenden der Quest wieder zum Dorfbewohner zurückkehren soll. 
12) Erstellen Sie eine neue Aktion für den Auslöser „Get Credit for Killing the Monster”. 
13) Wählen Sie als Aktions-Typ „Illuminate X as Primary” aus. 
14) Wählen Sie die Aktion aus, die Sie gerade erstellt haben. 
15) Geben Sie für die Eigenschaft „NPC” im „Properties“ Fenster den Wert „Database\npcs\tutorial-quest_villager.dbr“ ein. 
 Als nächstes müssen wir dafür sorgen, dass die Aufgabe „Kill The Monster” als erledigt angesehen wird. 
16) Erstellen Sie eine neue Aktion des Typs „Update This Quest's Map Marker” im Auslöser „Get Credit for Killing the 
Monster”. 
17) Geben Sie für die Eigenschaft „BulletPointTag” den Wert „Kill The Monster” ein. 
 Wir sollten die Aufgabe aktualisieren, damit sie abgehakt wird. 



18) Ändern Sie den Wert der Eigenschaft „DoCompleteBulletPoint” auf „True”. (Sollte vorgegeben sein.) 
 Allerdings benötigen wir auch noch eine weitere Aufgabe, die dem Spieler mitteilt, dass er zum Dorfbewohner 
zurückgehen sollte. 
19) Erstellen Sie eine neue Aktion des Typs „Update This Quest's Map Marker” für den Auslöser „Kill the Monster”. 
20) Geben Sie für die Eigenschaft „BulletPointTag“ den Wert „Return To The Villager” ein. 
 Außerdem sollten wir das Kästchen im Aufgabefenster des Spiels aktualisieren. 
21) Geben Sie für die Eigenschaft „DescriptionTag“ den Wert „You have killed the monster. Go Tell The Villager.“ ein. 
22) Setzen Sie den Wert der Eigenschaft „DoCompleteBulletPoint“ auf „False”. 
 
12.2.6 Beenden der Quest 
 Abschließend muss der Spieler zum Dorfbewohner zurückgehen und seine Belohnung abholen. 
1) Erstellen Sie einen Auslöser im Schritt „Claim the Reward”. 
2) Geben Sie für die Auslöser-Eigenschaft „Name” den Wert „Talk To Guy To Finish Quest” ein.  
 Die erste Bedingung für diesen Auslöser ist, dass er stattfindet, wenn der Spieler mit dem Dorfbewohner spricht. 
3) Erstellen Sie eine Bedingung des Typs „On Interact with X“ für den Auslöser „Talk To Guy To Finish Quest”. 
4) Geben Sie für die Eigenschaft „NPC” den Wert „Database\npcs\tutorial-quest_villager.dbr“ ein. 
 Bevor wir dem Spieler die Belohnung geben, müssen wir allerdings noch sicherstellen, dass er das Monster auch 
getötet hat. 
5) Erstellen Sie eine neue Bedingung vom Typ „Owns Token X“ für den Auslöser „Talk To Guy To Finish Quest”. 
6) Geben Sie für die Eigenschaft „Token“ den Wert „Killed_Satyr“ ein. 
 Als erstes verändern wir den Dialog des Dorfbewohners. Anstatt den Spieler zu bitten, das Dorf zu retten, sollte er 
ihm nun dafür danken, dass er es gerettet hat. 
7) Erstellen Sie eine Aktion des Typs „Update X's Dialog to X“ für den Auslöser „Talk To Guy To Finish Quest”. 
8) Geben Sie für die Eigenschaft „DialogPak“ der neuen Aktion den Wert „Database\dialog\tutorial-villager_dialog_b.dbr“ 
ein. 
9) Geben Sie für die Eigenschaft „NPC“ der neuen Aktion den Wert „Tutorial-Quest_Villager.dbr“ ein. 
 Wir ändern als nächstes den Aufgaben-Marker so, dass er anzeigt, dass wir erfolgreich mit dem Dorfbewohner 
gesprochen haben. 
10) Erstellen Sie eine neue Aktion des Typs „Update This Quest's Map Marker” für den Auslöser „Talk to Guy to Finish 
Quest”. 
11) Geben Sie für die Eigenschaft „BulletPointTag“ der neuen Aktion den Wert „Return To The Villager” ein. 
12) Setzen Sie den Wert der Eigenschaft „DoCompleteBulletPoint” der neuen Aktion auf „True“. 
 Der Dorfbewohner gibt dem Spieler nun wie versprochen die Belohnung in Bar. 
13) Erstellen Sie eine neue Aktion des Typs „Give Player N,N,N gold“ zum Auslöser „Talk To Guy To Finish Quest”. 
14) Wählen Sie die neue Aktion aus. 
15) Geben Sie für die Eigenschaft „MoneyEpic“ den Wert „200“ ein. 
16) Geben Sie für die Eigenschaft „MoneyLegendary” den Wert „300“ ein. 
17) Geben Sie für die Eigenschaft „MoneyNormal” den Wert „100“ ein. 

 
 Indem wir diese Quest als beendet ausweisen, verhindern wir, dass dieser Charakter sie noch einmal spielen 
kann. 
18) Erstellen Sie eine neue Aktion des Typs „Complete Quest Now” für den Auslöser „Talk to Guy to Finish Quest”. 
19) Geben Sie für die Eigenschaft „QuestFile“ der neuen Aktion den Wert „Resources\Quests\Tutorial-
Save_The_Village.qst“ ein. 
 
12.3 Die Aufgaben sichtbar machen  
 Wenn Sie zu diesem Zeitpunkt alles erstellen und die Karte im Spiel ausprobieren würden, müsste sie theoretisch 
funktionieren. Nachdem Sie das Monster getötet hätten, würde sich der Dialog verändern, und wenn Sie zum zweiten Mal 
mit dem Dorfbewohner reden würden, bekämen Sie Ihre Belohnung für das Beenden der Quest. Unglücklicherweise 
würde keine der Aufgaben in Ihrer Aufgabenliste erscheinen, und es gäbe keinen Hinweis auf der Karte, wo der Spieler 
sich befindet. Um das zu erreichen, benötigen wir Karten-Marker  und die Overlay -Funktion. Ein Karten-Marker besteht 
aus einigen wenigen Teilen. Der Marker selbst ist ein Ring, der in der Karte der Aufgabenliste erscheint, wenn der Spieler 
seine Aufgaben checkt. Das Overlay ist der Edelstein innerhalb des Karten-Markers. Er zeigt an, dass sich der Spieler in 
dieser Zone aufhält. Schließlich muss der Karten-Marker noch mit einer Quest-Positions-Karte verknüpft werden. 



 
12.3.1 Erstellen eines Overlays  
 Zuerst wollen wir uns einige Dateien von Titan Quest als Vorlagen besorgen. 
1) Öffnen Sie den Art Manager. 
2) Klicken Sie auf die „Database“ Registerkarte. 
3) Wählen Sie im Menü „Mod -> Import Record...“. Erweitern Sie den Ordner „database -> Records -> InGameUI -> 
Player Quests -> Map Markers” im Verzeichnis-Fenster. 
4) Kopieren Sie die Datei „GreeceQ1_overlay.dbr” im Ordner-Fenster. 
5) Klicken Sie im Verzeichnis-Fenster auf „Tutorial12\database -> Records”. 
6) Fügen Sie im Ordner-Fenster eine Kopie der Datei „GreeceQ1_overlay.dbr“ ein. 
7) Benennen Sie den neuen Eintrag in „Tutorial-Save_The_Village_overlay.dbr“ um. 
 
12.3.2 Erstellen eines Karten-Markers  
1) Öffnen Sie den Art Manager. 
2) Klicken Sie auf die „Database” Registerkarte unterhalb des Verzeichnis-Fensters. 
3) Erweitern Sie den Ordner „database -> Records -> InGameUI -> Player Quests -> Map Markers” im Verzeichnis-
Fenster. 
 Kopieren Sie den Eintrag „GreeceQ1.dbr”. 
4) Kopieren Sie den Eintrag „GreeceQ1.dbr” im Ordner-Fenster. 
5) Klicken Sie im Verzeichnis-Fenster auf „Tutorial12\database -> Records”. 
6) Fügen Sie eine Kopie der Datei „GreeceQ1.dbr“ im Ordner-Fenster ein. 
7) Benennen Sie den neuen Eintrag in „Tutorial-Save_The_Village.dbr“ um. 
 Öffnen Sie den Eintrag „Tutorial-Save_The_Village.dbr”, um ihn zu bearbeiten. 
8) Machen Sie mit der linken Maustaste einen Doppelklick auf den Eintrag „Tutorial-Save_The_Village.dbr“. 
9) Wählen Sie im Hierarchie-Fenster die Gruppe „All Groups -> Config“ aus. 
 Legen Sie fest, dass unsere Quest hier stattfinden wird. 
10) Ändern Sie den Wert der Eigenschaft „questFile“ auf „Tutorial12\assets\Tutorial-Save_The_Village.qst“. 
11) Ändern Sie den Wert der Eigenschaft „dialogPakFile” auf „Tutorial12\database\Records\Tutorial-
Villager_Dialog_B.dbr“. 
 Verbinden Sie den Marker mit dem richtigen Overlay. 
12) Ändern Sie den Wert der Eigenschaft „markerButtonOverlay” auf „quest -> tutorial-save_the_village_overlay.dbr“. 
 Ändern Sie den Namen der Quest, der im Spiel erscheint. 
13) Ändern Sie den Wert der Eigenschaft „markerDescriptionTag“ auf „Go Save The Village“. 

 
 
12.3.3 Erstellen einer Quest-Positions-Karte 
1) Öffnen Sie den Art Manager. 
2) Klicken Sie auf die „Database” Registerkarte. 
3) Erweitern Sie im Verzeichnis-Fenster den Ordner „database -> Records -> InGameUI -> Player Quests“. 
 Erstellen Sie eine Kopie von „QuestLocationMap1.dbr”. 
4) Kopieren Sie „QuestLocationMap1.dbr”. 
5) Klicken Sie im Verzeichnis-Fenster auf „Tutorial12\database”. 
6) Fügen Sie eine Kopie von „QuestLocationMap1.dbr” ein. 
7) Benennen Sie den neuen Datenbank-Eintrag in „Tutorial-Quest_Location_Map.dbr“ um.  
8) Öffnen Sie „Tutorial-Quest_Location_Map.dbr“ im Ordner-Fenster durch Doppelklick mit der linken Maustaste, um die 
Datei zu bearbeiten. Es öffnet sich das „Editing Record“ Fenster. 
9) Wählen Sie im linken Hierarchie-Fenster auf der linken Seite „All Groups -> Config“ aus. 



 
10) Machen Sie mit der linken Maustaste einen Doppelklick auf die Werte-Zelle der Eigenschaft „mapMarkers“. 
 Es öffnet sich das „Editing variable “ Fenster. 
 Wir fangen am besten damit an, alle alten Karten-Marker von unserer Quest-Positions-Karte zu löschen. Jede 
Zeile entspricht dabei einer Quest. 
11) Wählen Sie einen der aktuellen Einträge aus der Tabelle im unteren Teil des Fensters. 
12) Klicken Sie auf „Delete” in der „Array Editing Controls”  Unterteilung in der Mitte. 
13) Klicken Sie so oft auf „Delete”, bis alle Einträge gelöscht wurden. 
 Nun werden wir den neuen Marker einsetzen, den wir gerade angelegt haben. 
14) Klicken Sie auf „New” im „Array Editing Controls ” Fenster. 
15) Machen Sie in der Zeile, die Sie gerade erstellt haben, einen Doppelklick auf die Werte-Zelle unter „Value“. 
16) Geben Sie den Pfad des Karten-Markers ein, den Sie für diese Quest erstellt haben: „Records\InGameUI\Player 
Quests\Map Markers\Tutorial-Save_The_Village.dbr“. 
17) Klicken Sie auf „Apply”. 
18) Klicken Sie auf „OK”. 
19) Schließen Sie das „Editing Record” Fenster. 
 Es öffnet sich ein Fenster zur Bestätigung, dass Sie die Änderungen im Datenbank-Eintrag speichern wollen. 
20) Klicken Sie „Yes”. 
 
 
12.4 Einfügen von Quests in Karten  
 
12.4.1 Platzieren von Quest-Objekten  
 Dies dürfte Ihnen bekannt vorkommen, hier ist aber trotzdem noch mal eine kleine Auffrischung. 
1) Öffnen Sie den Editor. Wählen Sie das Mod „Tutorial12“ aus. 
2) Öffnen Sie die Welt „custommaps\Tutorial12\source\Tutorial – Save_The_Village.wrl”. 
3) Öffnen Sie „Tutorial-Save_The_Village_Terrain.lvl” im Editor Mode. 
4) Wählen Sie das Objekt-Platzierungs-Werkzeug aus. 
 Setzen Sie den speziellen Dorfbewohner ein. 
5) Platzieren Sie das Objekt „CustomMaps -> Tutorial12 -> database -> Records -> Tutorial-Quest_Villager“ im Gelände. 
 Setzen Sie den speziellen Satyr ein. 
6) Platzieren Sie das Objekt „CustomMaps -> Tutorial12 -> database -> Records -> Tutorial-Quest_Satyr“ im Gelände. 
 Setzen Sie einen Spawn-Punkt ein. 
7) Platzieren Sie das Objekt „records -> controls -> spawnplayer“ im Gelände. 
8) Wechseln Sie in den Layout Mode. 
9) Klicken Sie in der Menüleiste auf „Build -> Rebuild All Maps”. 
10) Klicken Sie in der Menüleiste auf „Build -> Rebuild All Pathing”. 
11) Klicken Sie in der Menüleiste auf „File -> Save All“. 
 
 
12.5 Erstellen und Testen  
 
12.5.1 Alles Erstellen  
1) Öffnen Sie den Art Manager. 
2) Wählen Sie „Tutorial12” aus. 
3) Klicken Sie in der Menüleiste auf „Build -> Build“. 
 Es werden nun alle Güter von Tutorial12 erstellt. 
4) Klicken Sie auf die „Database” Registerkarte unterhalb des Verzeichnis-Fensters. 
5) Finden Sie im Verzeichnis-Fenster den Ordner „Tutorial12\database”. 
6) Klicken Sie mit der rechten Maustaste auf den Ordner „Tutorial12\database“. 
7) Klicken Sie im Popup-Menü auf „Build”. 
 Die Datenbank für Tutorial12 wird erstellt. 
  

Und das war’s. Wenn Sie jetzt in das Spiel gehen und die selbst erstellte Karte „Tutorial-Save_The_Village“ 
spielen, sollte es ganz nach Plan laufen. Wenn Sie mit dem Dorfbewohner sprechen, tauchen die Aufgaben in der Liste 
auf, wenn Sie das Monster töten, wird die Liste aktualisiert, und wenn Sie dann nach getaner Arbeit mit dem 



Dorfbewohner sprechen, bekommen Sie Ihre Belohnung. 


